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Chapter One 

Welcome to Opal-RAD 
 
This chapter officially welcomes you to Opal-RAD Client 
Worklist and Web Worklist.  The chapter covers mouse 
button fundamentals, introduces the two main screens, the 
Study List and the Image Viewer, and offers a brief look at 
what else is available in this and other applications in the 
Opal-RAD suite of medical imaging tools. We will also detail 
the minimum hardware and software requirements to run 
Opal-RAD, as well as, security considerations. 
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Welcome to Opal-RAD 
 
The Opal-RAD suite of PACS applications was developed 
specifically to handle the DICOM protocol, for both 
transmitting and viewing DICOM images and data elements.  
The applications were developed so that access to the 
PACS can occur from any Microsoft Windows computer with 
Internet capabilities, and offer an interface that users find to 
be quite intuitive after some initial learning. 
 
The Opal-RAD applications deal with all manner of DICOM 
images and modalities, including MR, CT, CR, US, and 
many others. These images can be viewed, manipulated, 
annotated, transmitted to other facilities, printed, animated 
and stored using the Opal-RAD suite. 
 
This manual is concerned primarily with the Opal-RAD Client 
Worklist, Web Worklist, and Image Viewer applications. The 
basic functionality of the Client Worklist and Web Worklist 
alternates between finding a study and viewing the images it 
contains.  Thus, the Client and Web Worklists have been 
divided into two different screens. 
 
The first is the Study List, which is used for searching and 
managing your studies. The second screen is the Image 
Viewer, which is used for viewing and manipulating the 
images contained in the study. 
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Features of the Client and Web Worklists 
 
Opal-RAD Client Worklist and Web Worklist are highly 
configurable and modular, but there are some functional 
differences between them. The Web Worklist includes most 
of the advanced Study List features and the entire Image 
Viewing features, but cannot create Patient CDs or importing 
images and scanned documents. The Client Worklist 
includes all of the advanced Study List and Image Viewing 
features mentioned above. Available modules in the Client 
Worklist add to this functionality by providing: 
 

• Sending and Receiving images over phone line, local 
area networks, and the Internet.  The Opal-RAD suite 
features truly impressive teleradiology capabilities, 
including DICOM transmission/receive, and a 
proprietary format for transmissions between two 
Opal-RAD machines utilizing compression, 
encryption, and auto-resume functions.  

• Acquisition of images. Client Worklist can be 
configured as a QC (quality control) Acquire station 
and connected to one of several compatible scanners, 
such as the Orex PcCR line of CR scanners, the 
VIDAR Diagnostic Pro film digitizer, Lumisys Film 
digitizers, frame-capture devices, and any acquisition 
device that uses DICOM. 

• Film printing. For those instances where film is 
essential, Client Worklist provides advanced 
capabilities and control over the final appearance of 
the printed film, and is compatible with virtually all film 
cameras. 
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Feature Client Web 
Acquiring Images X  
Printing to Film X  
CD Burning X  
Deleting Studies X  
Merging Studies X  
Importing JPEGs X  
Importing Scanned Documents X  
Importing Images CD X  
Edit Study and Patient Data X  
Custom Study List Filters X X 
Comparing Exams X X 
Sending Studies X X 
Adding Study Notes X X 
Transcription  X 
User/Group Administration  X 
DICOM Printer Creation  X 
DICOM Print Queue  X 
DICOM Send Queue  X 

Product Comparison 
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The Study List 
 
As stated earlier, Opal-RAD Client Worklist and Web 
Worklist consist of two interfaces (screens), each with a 
separate function. The first interface you will see after 
logging on to Client Worklist or the Web Worklist will be the 
Study List screen. This interface is used for searching and 
selecting patient studies and sending studies to other users.   
 
The study list itself is divided into many columns including 
Status, Modality, Patient Name, Study Date, Study 
Description, etc. Studies can be sorted by any of these 
columns and the column headers actually double as search 
fields. All of these listing options enable you to quickly find 
your desired study among the thousands of exams in your 
database. 
 
Next to each exam/study in the study list are buttons, which 
provide the user access to some of the advanced features of 
the Worklist, including: 
 

• Patient Exam History Notification 
• View Key Images 
• Listen to Dictation and/or Transcribe (optional feature) 
• View Report (optional feature) 

 
Below the study list is the Patient Studies window, which is 
used to view all of a patient’s prior exams. At the bottom of 
the screen is a toolbar, which is used to open or compare 
exams, filter the study list, and navigate through your 
studies. 
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To view your study, you simply double-click it.  This will open 
the exam in the Image Viewer screen. This will be explored 
in more detail in the next topic, but for now lets look at just a 
few of the differences between the Client Study List and the 
Web Study List. 
 
Client Worklist 
 
At the top of this screen, are tabs separating the Study List 
from the Study Manipulation and Study Merge and Delete 
tabs. The Study List screen also gives you access to other 
features of Client Worklist, such as sending images to other 
doctors, creating Patient CDs, and acquiring images from 
film and plate scanners (not included in the Web Worklist.) 
 
Web Worklist 
 
At the top of this screen, are tabs separating the Study List 
from the Settings and Administration sections and a main 
window. With the Settings tab, users can modify their Study 
List’s display settings. With the Administration tab, your 
administrator can add, edit, and delete user and group 
accounts. They can also create DICOM printers and send 
destinations, and manage the print queue. 
 
 
☼ The specifics of all of the features described above will be 
covered in greater detail in the chapters that follow. 
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The Client Worklist Screen 

 

 
The Web Worklist Screen 
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The Image Viewer 
 
The second component of the Opal-RAD suite is the Image 
Viewer screen. Unlike the Study List component, there is no 
functional difference between the Image Viewer of the Client 
Worklist and the Image Viewer of the Web Worklist. 
 
The Image Viewer offers a vast array of powerful tools and 
functions for viewing and diagnosing medical images. 
Images can be window/leveled manually or automatically, 
sharpened, flipped, rotated, zoomed, panned, and inverted.  
You can view “cut-lines” (image intersections), Hounsfield 
Units (for CT), and DICOM elements (“tags”). Images can 
also be printed or combined with other images to create Pre-
Op Studies. 
 
The Image Viewer screen also has a large number of image 
marking tools to assist in your diagnosis. Various annotation 
tools are available, ranging from simple arrows and text 
boxes to angle and distance measurements. 
 
Please see the appropriate sections of this manual for more 
discussion of the features.  You will find that most of the 
features can be accessed quickly through a toolbar button or 
the dropdown menus. 
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The Image Viewer screen 

 
 
With the Image Viewer, as with most software applications, 
development is an ongoing process. The Opal-RAD Image 
Viewer (sometimes called Opal Viewer) is constantly being 
enhanced to include additional functionality or simplify 
complex tasks.  
 
New releases of the software can be downloaded and 
installed via a link on the Web Worklist’s Study List screen. 
For instructions on how to upgrade your Image Viewer, 
please see “Chapter Two: Installing and Updating the Image 
Viewer“. 
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Easy To Use 
 
Opal-RAD is designed to combine a multitude of powerful 
tools with an intuitive and configurable interface. 
 
With any software package, there is an initial learning curve 
that must be surmounted. Trial and error will lead to 
familiarization and efficiency.  First-time users of Microsoft 
Windows often become accustomed to it within a week or 
two of regular use. 
 
Opal-RAD builds on this by using menus, shortcuts, and 
operations that are similar to most other Windows programs, 
thus decreasing the learning curve and familiarization period.  
The Opal-RAD applications make extensive use of toolbars, 
context menus, drag-and-drop functionality, menus, and 
shortcut keys to provide even more efficiency to your busy 
schedule. 
 
The computer’s mouse has two buttons (some newer 
models also have a third, the “middle” button, and/or a scroll-
wheel in the center.)  The behavior of these two buttons, 
referred to as the “left” and “right” buttons, respectively, is 
consistent throughout Opal-RAD software. 
 
Left Mouse Button 
 
Almost all tasks are performed with this button.  A single 
click is used extensively throughout the software to select an 
item (e.g., select a study in the Study List, select an image in 
the Image Viewer, select a recipient on the “Send To” dialog, 
etc.) or activate a feature (e.g., clicking the appropriate 
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toolbar button to activate the Zoom tool, clicking the “OK” 
button on a dialog in response to a question, etc).  
 
Right Mouse Button 
 
A single click with this button reveals a pop-up menu 
containing functions and options pertinent to the area of the 
software you are currently using.  “Dragging” (hold the button 
down and move the mouse) this button is used primarily for 
functions like windowing an image while you view it. 
 
These behaviors described above are consistent with most 
other software packages designed to run on the Microsoft 
Windows platform, so you will find that you use the same 
mouse skills across multiple software products, and you will 
very quickly become accustomed to using the mouse. 
 
☼ Please see Chapter 12:  Windows Primer if you are new 
to the Windows operating system. 
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How to Use This Manual 
 
The next chapter offers a walkthrough for typical usage of 
the Client Worklist and Web Worklist, which includes, 
logging on, locating a study in the Study List screen, viewing 
and basic manipulation of the study’s images in the Image 
Viewer screen, and returning to the Study List. 
 
The rest of the chapters explore individual sections of the 
Client Worklist and Web Worklist in greater detail, including 
the Study List and Image Viewer screens.  The following 
feature are available for the Client Worklist:  advanced 
image viewing and manipulation tools / operations, printing 
to paper and film, creating Patient CDs (“CD burning”), 
sending and receiving exams, and acquiring exams from a 
supported acquisition device. 
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Minimum Requirements 
 
Opal-RAD PACS Viewer Minimum Requirements: 
 

• Window’s XP Operating System 
• 1 Gigabyte RAM 
• 20 Gigabytes of free space on hard drive 

 
 

Security Statements 
 
Opal-RAD will be accessible from any computer with internet 
access. In order to keep the Opal-RAD database secure, 
there are several steps you should take to ensure the 
security of your data, and the confidentiality of your records. 
 
Since all Internet communication is subject to malicious 
attacks from outside sources, it is highly recommended that 
your organization purchase a 128-bit SSL Certificate from a 
trusted authority, such as Verisign or Thawte, and install it 
on your web server. By using a SSL Certificate you can 
ensure that all Internet access to your server is encrypted 
and protected from outside sources. 
 
Each user will have a personal user name and password 
with which to access the Opal-RAD Worklist. Your Opal-RAD 
administrator will be responsible for determining those user’s 
rights and defining security protocols, such as user the time-
out duration, password length, and permissions.  
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Chapter Two 

Basic Workflow of Opal-RAD 
 

This chapter offers a walkthrough for typical usage of the 
Client Worklist and Web Worklist.  The walkthrough includes 
locating a study in the Study List screen, viewing and basic 
manipulation of the study’s images in the Image Viewer 
screen, and returning to the Study List. 
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Introduction 
 
Opal-RAD Viewer (a.k.a. “Viewer” for brevity) is an 
application that allows users to view and manipulate vast 
amounts of DICOM and patient information.  
 
There are two basic functions in the viewer: selecting a 
patient and viewing that patient’s images.  As such, the 
program is divided into two interfaces: the Study List screen 
for selecting patient studies, and the Diagnostic-Quality 
Image Viewer screen for viewing and manipulating the 
images.  As you use the viewer, you will find that you 
alternate between these two screens quite frequently. 
 
In this chapter we will look at a sample user session of the 
Viewer.  This session includes the following steps: 
 

• Logging In 
• Study List screen 
• Sorting and Searching the Study List 
• Installing the Image Viewer software 
• Opening a study in the Image Viewer 
• Image Viewing screen 
• Closing a study 
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Step 1:  Logging In 
 
In order to begin using either the Client Worklist or Web 
Worklist applications you must first log in to the system. 
Logging in will allow you access to the list of patient studies. 
The Log-In Screen contains of two fields that must be filled 
in prior to logging on: User Name and Password. 
 
► To login to the Client Worklist 
 
1. Double-Click on the “Opal-RAD Client Worklist” icon on 

your desktop. 
2. Enter your User Name and Password, and then click 

LOG IN. 
 
► To login to the Web Worklist 
 
1. Open Internet Explorer or your Internet service provider. 
2. Type the web address to the Opal-RAD web server into 

the address bar and press ENTER. 
3. Enter your User Name and Password, and then click 

LOG IN.   
 
☼ The User Name and Password are both case sensitive. 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 24 

 
The Log-In Screen 

 
 
Please consult your PACS administrator, or similar authority, 
to receive your username and password. Requiring a valid 
username and password is an effective security measure for 
protecting the records of your patients. 
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Step 2:  The Study List screen 
 
The first interface you will see after logging on will be the 
Study List screen (Web Worklist pictured). This interface is 
used for searching and selecting patient studies and sending 
studies to other users. 
 

 
 
Above the study list, are tabs separating the study list from 
the settings and admin sections. Below the list you will find 
your toolbar and page navigation controls. 
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Step 3:  Sorting and Searching Your 
Studies 
 
The Study List window is divided into columns such as 
Status, Modality, Patient Name, etc. The data contained 
under these columns can be both sorted and searched. 
 
► To sort the study list 
 
1. Left-Click on either the up or down arrows next to the 

column name. 
 
 
The listing will now be sorted by whichever column you 
chose, but this may not be sufficient for finding a particular 
study if the list is very large. Our next step is to filter the list 
by performing a quick search. 
 
► To search (filter) the study list 
 
1. Type in the white space directly below the column 

heading. For example, you might enter “Smith” under the 
column header labeled Patient Name. 

2. Press ENTER to apply the search filter. 
 
The Patient listing is updated to display only the patients that 
match the search criteria.  From this reduced listing we can 
see our desired patient. 
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Step 4:  Installing and Updating the Image 
Viewer 
 
This step is optional. Only update your image viewer if you 
do not have the latest version. Only users with administrative 
rights on the computer being used will be able to install the 
viewer. 
 
► To Install or Update your Image Viewer 
 
1. Left-Click on the Download Viewer link in the top right-

hand corner of the screen. 
2. Click the Open button on the dialog box that appears to 

begin the Image Viewer installer (see below). 
3. When it’s completed, simply click the OK to return to the 

Study List 
 
 

Step 5:  Opening a Study in the Image 
Viewer 
 
Once we have located the study (Exam) that we would like 
to view we can open it in the Image Viewer. 
 
► To open a study in the Image Viewer 
 
1. Double-Click on a study in the study list. 
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Step 6:  The Image Viewer screen 
 
After opening the selected study you will be taken to the 
Image Viewer screen. On the left side of the screen is the 
Series Window, which displays thumbnails for each series in 
the study.  The largest window in the workspace is the 
viewing window, where the image(s) are displayed. 
 
To display an image in the viewing window, double click on 
the thumbnail or drag and drop a thumbnail to the viewing 
window. After the image has been opened, you will then 
have access to an array tools for modifying or annotating 
your image. 
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Step 7:  Closing a Study 
 
When you are finished viewing the study, there are two 
methods of closing the study to return to the Study List 
screen. 
 
► To close a study 
 
1. On the File menu, Left-Click on Exit, or Left-Click on the 

“X” in the upper right corner of the Image Viewer. 
2. A Close Study dialog box will appear. Select the 

appropriate options and Left-Click the OK button. 
 

 
 
 
If you are not prompted, or if you wish to have your changes 
automatically saved, please consult the topic Auto-Save 
Options in Image Viewer Settings Chapter for more details. 
 
Upon returning to the Study List, you will notice that your 
previous sort and search filter are still in place. To bring back 
the entire patient list, delete everything from the search fields 
and press ENTER, or Left-Click the ALL button. 
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Going Further 
 
This completes our sample session using Opal-RAD Client 
Worklist / Web Worklist. We have only looked at the most 
basic functionality of the software: selecting and viewing a 
study.   
 
The both the Study List and Image Viewer contain many 
useful and specialized functions designed to increase 
efficiency and the quality of reading patient studies. Please 
consult the more advanced sections of this manual to 
familiarize yourself with those features. 
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Chapter Three 

The Study List Screen 
 
This chapter explores in detail the first of two screens you 
will alternate between while using the Client Worklist or the 
Web Worklist. This screen lists all of the exams in the 
database(s) you are connected to, allowing you to filter and 
sort the listing as you navigate the list.  From this screen you 
can also change a study’s status, send it to another site, 
create Patient CDs, and view study histories. 
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An Overview of the Study List Screen 
 
Let’s start by identifying this screen’s distinct parts. 
 
The Study List is the largest and most important part of this 
screen, holding the actual listing of studies in your database.  
The list is divided into several columns to organize all of the 
information available – like patient name, sex, and birthdate, 
the study’s status, number of series and number of images, 
etc. 
 
The Patient’s Studies window works in conjunction with the 
study list to quickly show you all of the studies associated 
with the selected patient. When a study in the Study List is 
selected (highlighted) the Patient Studies window will show 
that patient’s previous exams in the region just below the 
Study List. 
 
The Toolbar sits below the Patient Studies window. On this 
toolbar you will find the controls necessary for opening and 
comparing studies, printing studies, burning CDs, importing 
JPEG images and scan documents, and record navigation.  
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Client Worklist Screen 

 
 

 
Web Worklist Screen 
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Patient Studies Window 

 
When you single-click on a study in the study list it becomes 
the selected study. The Client Worklist will quickly search 
through the study list to find every other study for this 
selected patient and after a moment displays these studies 
in the Patient’s Studies window. To perform this same 
search using the Web Worklist, Left-Click on the “P” icon 
located to the left the study entry. 
 
This search is based on the patient’s ID. This enables you to 
quickly see all studies for the patient you are interested in.  
You can also select the study to view from this window just 
as you do from the Study List window.  The “P” located to 
the left of a Study List entry is another indication that the 
patient has other exams in PACS. 
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Study List Buttons 
 
The Study List buttons appear at the bottom of the Study List 
screen and to the left of the Study entries. The buttons will 
change depending on which version of the Opal-RAD 
software you are using (Client Worklist or Web Worklist). 
  
 

 
Client Worklist buttons 

 
 

Web Worklist buttons 
 

 
Study List buttons 

 
 

•   Patient Exam History Notification:  When 
highlighted, this icon will indicate that the patient has 
multiple exams in the system. 

•   Select Study Check Box:  Check this box to 
compare or open multiple studies. 

•   Key Image:  When highlighted, this icon will 
indicate that key images exist for the study. 

•   Transcription: Opens a window for adding a 
transcription to the study. 

•   XMLData:  Displays a study’s DICOM data in 
XML format. 

•   Add Note:  This is used to add notes to a study. 
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•   View Report:  This displays a study’s completed 
exam report. 

•   RIS Docs:  This will open a list of any documents 
scanned in using your integrated Opal-RIS package. 

• Open:  This feature will allow you to consecutively 
load up to five studies. 

• Compare:  This feature allows loading of two studies 
for comparison. 

• Prefetch:  This allows users to download studies to 
their local hard disk. 

• On Call:  This uses a pre-defined search filter in 
conjunction with Prefetch feature to download studies 

• View Report:  Opens a PDF version of the radiology 
report. 

• CD Burn:  This feature allows the user to burn patient 
studies to a CD. 

• Send:  This is used to DICOM send a study to 
another PACS. 

• DICOM Print:  This is used to print a study to film. 
• Scan Paper:  This allows the user to attach a 

scanned document to the selected study. 
• Import JPG:  This allows the user to attach a JPG 

image to the selected study. 
• Import CD:  This feature allows the user to import 

DICOM images from a CD. 
• Refresh:  This button performs a manual refresh of 

the study list. 
 
☼ CD Burn, Import JPG, Delete Study, Purge Study, and 
Scan Paper are only available from the Client Worklist. 
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Study List Navigation  
 
As the number of studies, or records, in your database 
grows it will be necessary to use the Study List’s record 
navigation toolbar to browse through the entire list. This 
toolbar (shown below) can be found at the bottom of the 
Study List screen. 
 
The number of records, number of pages, jump to page, and 
page forward/backward buttons are available from the 
bottom left corner of the screen. 
 
 

 
 
 

                    First    Previous    Next   Last 
 

 
► To move through your records 
 
1. Left-Click on the First or Previous button to move 

backwards through your records. 
2. Left-Click on the Next or Last button to move forwards 

through your records. 
 
► To go to a specific page 
 
1. Left-Click on the Jump To Page dropdown list. 
2. Select a page number from the list. 
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Opening a Study in the Image Viewer 
 
When you have located your desired study, you may open it 
for viewing one of two ways. 
 
► To open a study in the Image Viewer 
 
1. Double-Click on the study in the Study List window. 
 
-or- 
 
1. Left-Click on the check box to the left of the study in the 

Study List window. 
2. Left-Click on the Open button. 
 
 

 
 
 

 
 
 
☼ You may open up to five studies at a time by using the 
Open button method. Simply select all five studies prior to 
clicking the Open button. The studies will open one at a time. 
As each study is closed the next in line will open. 
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Study List Context Menus 
 
Both the Client and Web Worklists have a Right-Click 
context menu, which can be accessed by Right-Clicking on a 
study in the Study List. The contents of the context menu will 
depend on whether you are using Client Worklist or Web 
Worklist. For example, if you Right-Click on a study while 
using the Web Worklist, the following menu will appear: 
 

 
 
If you Right-Click on a study while using the Client Worklist, 
the following menu will appear: 
 

 
 
☼ We will examine each of these menu options in the pages 
and chapters that follow. 
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Changing the Status of a Study  
 
Each study in the system is assigned a “status.” The status 
acts as a marker to indicate at what point a study is at in its 
life-cycle. The valid status types are as follows: 
 

• Incomplete:  Studies are considered “incomplete” 
when either (a) the images are still coming into the 
system from the modality or another sender, or (b) the 
technologist has not yet validated this study. Studies 
of this type can be changed to Unread in a process 
known as “validating”. Once a study has been 
validated it cannot be changed back. 

• Unread:  Unread studies have been validated by a 
technologist and are awaiting diagnosis by the 
Physician/Radiologist. Images can no longer be 
added to the study. Studies of this type can be 
changed to Read.  

• Read:  Studies of this type have been already been 
diagnosed, or “read.” Studies of this type can be 
changed back to Unread. 

• Deleted:  Studies of this type have been marked for 
deletion from the PACS server. This feature is only 
available from the Client Worlklist and should rarely 
be used. Studies of this type can be changed back to 
Read or Unread. 

• STAT:  Marking a study STAT will highlight the study 
and move it to the top of the study list. A study that 
has been marked STAT implies that it is of great 
importance, and should be attended to first. 

 
 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 42 

Unlike the other statuses mentioned the STAT status is 
independent of the other types. So, for example, you could 
have a study marked both Unread and STAT 
simultaneously. 
 
► To change the status of a study 
 
1. Right-Click on the study to be changed. 
2. Select the appropriate status, such as Unread or STAT, 

from the context menu that appears (below). 
 

 
Web Worklist context menu 

 
The statuses that are displayed in the context menu will 
change depending on the current status of the study being 
changed. For example, if a study has been marked as Read, 
then the Unread option will appear in the context menu. 
 
 
☼ Marking a study as Deleted is only available from the 
Client Worklist. Please see the Chapter 8:  Patient/Study 
Administration for more details on deleting studies. 
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Add Notes to a Study   
 

  Add/View Note button 
 
If a note exists, the Add/View Note button will be highlighted.  
The typed notes will appear when the Add/View Note button 
is pressed.  You can attach as many notes as necessary to a 
study, with the last note being the most recent.  Once 
created, these notes cannot be removed. 
 
► To add notes to a study 
 
1. Left-Click on the Add/View Note button to the left of the 

Study Entry. 
2. Type the note in the bottom portion of the Note window.  
3. Left-Click on the Add Notes button to save the note, or 

Left-Click the “X” in the upper right-hand corner of the 
window to cancel. 
 

 
 
 
☼ To view notes from the Image Viewer, Right-Click on the 
Series/Stack Header and select View Notes. 
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Columns in the Study List 
 
The data that comprises your studies are displayed in a 
columnar format. To facilitate the the finding of studies, most 
of these columns can be sorted, searched, rearranged, and 
removed. 
 
The columns available in the Study List are: 
 

• Status 
• Modality 
• Series Count 
• Image Count 
• Patient Name 
• Patient ID 
• Description 
• Body Part 
• Study Date 
• Referring Physician 
• Gender 
• Date of Birth 
• Age 
• Accession Number 
• Institution Name 
• Reading Physician 
• Received Date 
• Department 
• Station 
• Fax Number 
• Approved Date 
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Sorting the Study List 
 
Most of the columns in both the Client and Web Worklists 
can be sorted to make finding data in a large study list 
easier. 
 
► To sort a column in Client Worklist 
 
1. Double-Click the column to be sorted. 
2. The direction of the arrow that appears on the column will 

indicate the direction of the sort. 
3. Double-Click the column again to change the sort. 
 

 
 
 
► To sort a column in Web Worklist 
 
1. Left-Click on either the Up-Arrow or Down-Arrow printed 

on the column header. 
 

 
 
 
Alphanumeric fields will be sorted as follows: 

• Ascending will sort from A to Z. 
• Descending will sort from Z to A. 

 
Date/Time fields will be sorted as follows: 

• Ascending will sort from oldest to newest. 
• Descending will sort from newest to oldest. 
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The Study List Filter (Searching) 
 
Sorting the study list by any column is handy enough, but 
once you begin to accumulate hundreds of studies, the list 
becomes quite long and more time-consuming to navigate 
by scrolling through it. 
 
Filtering what is displayed in the list becomes essential. 
Once a filter is applied the list will be updated to display only 
the studies that match the search criteria, making it easier to 
find your desired studies. There are a number of techniques 
for filtering, or searching, your studies: 
 
► To filter the study list with a search phrase 
 
1. Enter a search phrase in the textbox below the column 

header. For example, enter “Smith” under the column 
header labeled Patient Name. You may also enter a 
partial search phrase, such as “Sm.” 

2. Press ENTER to apply the search filter. 
 

   
 

 
☼ Some columns in the Study List window are pre-populated 
dropdown lists. To search by one of these fields, simply 
select a value from the dropdown list. To remove this value, 
just select the blank entry, or the ALL option, at the top of 
the list. 
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► To remove a filter from your study list 
 
1. Erase the search phrase from the search field and press 

ENTER. 
 
► To remove all filters from your study list 
 
1. Left-Click on the All button on your toolbar. 
 
► To display only Unread studies 
 
1. Left-Click on the Unread button on your toolbar. 
 
 

       
              Client Worklist                    Web Worklist 
 
 
► To use a Saved Search Filter 
 
1. Select a  filter from the Filters dropdown menu. 
 

 
 
 
☼ In order to use Saved Filters you must create them 
through the Web Worklist Settings window. Please see 
Chapter 10:  Web Worklist Settings for more details. 
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Refreshing the Study List 
 
Depending on his/her permissions, a user from one 
workstation could potentially add, remove, or modify a study 
on the study list. If there are other users operating from other 
workstations, they may not see these changes immediately. 
 
To ensure that your study list is showing the most current 
and up-to-date data, you may refresh the list. 
 
► To refresh the study list 
 
1. Left-Click on the Refresh button on your toolbar. 
 

 
 
 
Through the Web Worklist you may automatically refresh 
your study list based on a predefined interval. 
 
► To automatically refresh the study list 
 
2. Left-Click on the Auto checkbox on your toolbar. 
 
 

   
 
 
☼ The study list’s auto refresh interval can be modified using 
the “OPAL-RAD Local System Configuration” program from 
your Opal-RAD folder on the Start Menu. 
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Chapter Four 

Study List Settings 
 
This chapter will explain how to modify your user account’s 
Worklist settings. These settings include adjusting the 
column order and visibility, number of displayed rows, 
default sort column. Additionally, through the Settings tab we 
can also change the user’s password. 
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Introduction 
 
The Web Worklist Setting Tab (pictured below) is where 
users of all types (not just administrators) can adjust their 
display settings and passwords. It is important to understand 
that all changes to a user’s display settings and password 
will apply to both the Client Worklist and Web Worklist. 
 

 
 
 
The Settings tab includes the following sections: 
 

• Column Order:  This will allow you to enable, 
disable, and sort the columns on your study list.  

• Rows to Display:  This is the number of records that 
will be displayed per page on your study list. 

• Change Password:  This is where the user may 
change his or her password. 

• Default Sort Column:  This is the column that will be 
used to sort the study list. 

• Audio Player Lag Time:  Used to adjust the 
automatic rewind feature of the dictation control. 

• Auto Open Priors:  Activates the auto open feature. 
• Filter Menu:  This control panel will allow the user to 

create, edit, and delete pre-saved study list filters. 
 
☼ After any of these options have been changed, it is 
important to remember to Left-Click on the Save button. 
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Add/Remove Study List Columns 
 
You may find that you prefer to have certain columns listed 
in the Study List. This may be because the information is 
unnecessary or not available (e.g., many institutions do not 
use an Accession Number.) 
 
► To add Study List columns 
 
1. Left-Click on the Settings tab. 
2. Left-Click on the Column Order node to expand the 

column settings. 
3. Left-Click on a column in the Unselected list. 
4. Left-Click on the Add button to move the column to the 

Selected list. 
5. When you are done adding columns, Left-Click on the 

Save button to save your changes and return to the 
Study List. 

 
 
When a column is added to the Selected list box, it will 
automatically appear at the bottom of the list. For 
instructions on moving the column on the list, please see the 
next topic, “Rearrange Study List Columns.” 
 
► To remove Study List columns 
 
1. Left-Click on the Settings tab. 
2. Left-Click on the Column Order node to expand the 

column settings. 
3. Left-Click on a column in the Selected list. 
4. Left-Click on the Remove button to move the column to 

the Unselected list. 
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5. When you are done removing columns, Left-Click on the 
Save button to save your changes and return to the 
Study List. 

 
You may add or remove all columns at once by clicking the 
Add All or Remove All buttons (these are the bottom two 
buttons circled below). 
 

 
 

  Add Selected 

  Remove Selected 

  Add All 

  Remove All 
 
 
☼ It is not necessary to select a column from either list box 
when using the Add All or Remove All feature. 
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Rearrange Study List Columns 
 
The columns that appear on the study list may be 
rearranged in any order desired. The order in which they 
appear in the “Selected” list (from top to bottom) will be the 
order in which they appear on the Study List (from left to 
right). For example, if the “Status” column is the first on the 
list, it will be the first column on your Study List.  
 
► To rearrange the Study List columns 
 
1. Left-Click on the Settings tab. 
2. Left-Click on the Column Order node to expand the 

column settings. 
3. Left-Click on the column to be moved in the Selected list. 
4. Left-Click on either the Up or the Down arrow (circled 

below). 
5. When you are done sorting columns, Left-Click on the 

Save button to save your changes and return to the 
Study List. 
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Study List Rows 
 
By default, when the Study List contains more records than 
will fit on the screen you will need to use the record 
navigation toolbar to page through all of the records (see the 
section on Record Navigation for more information). 
 
However, you can adjust the number of records, which 
appears on each page of your Study List. 
 
► To adjust the number of rows/records to display 
 
1. Left-Click on the Settings tab. 
2. Left-Click on the Rows to Display node to expand the 

row settings. 
3. Left-Click on the dropdown list box and select a value 

(10, 20, 30, 40, or 50). 
4. Left-Click on the Save button to save your changes and 

return to the Study List. 
 
 

 
 
 
 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 56 

Changing Your Password 
 
In order to log in to the Opal-RAD PACs server, you need to 
pass the system a username and password (see “Logging 
On” in Chapter 2:  Basic Workflow of Opal-RAD for more 
information). If you would like to modify the password you 
can do so through the Web Worklist Settings Tab. 
 
► To change the user’s password 
 
1. Left-Click on the Settings tab. 
2. Left-Click on the Change Password node to expand the 

password settings. 
3. Enter your new password in the textbox. 
4. Left-Click on the Save button to save your changes and 

return to the Study List. 
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Default Sort Column 
 
By default, The Study List is sorted on the “Study Received 
Date” column. If you would like to modify this default 
behavior, you can do so through the Web Worklist Settings 
Tab. 
 
► To modify the default sort column 
 
1. Left-Click on the Settings tab. 
2. Left-Click on the Default Sort Column node to expand 

the Study List column sort settings. 
3. Select a column from the Default Sort Column 

dropdown list box. 
4. Select a sort order (Ascending or Descending) from the 

sort type dropdown list box. 
5. Left-Click on the Save button to save your changes and 

return to the Study List. 
 
 

 
 
 
☼ See Chapter 3:  The Study List Screen for more 
information on manually sorting columns in the Study List. 
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Audio Player Lag Time 
 
The Dictation Audio Control will automatically rewind a 
predefine amount of time every time the Play Foot Pedal is 
release and re-depressed. Your “Transcriptionist” User 
Group might benefit by adjusting the amount of time the 
audio file automatically rewinds. This can be done through 
the Web Worklist Settings Tab. 
 
► To modify the default sort column 
 
1. Left-Click on the Settings tab. 
2. Left-Click on the Audio Player Lag Time node to expand 

the Audio Player Lag Time settings. 
3. Select a value from the dropdown list box. 
4. Left-Click on the Save button to save your changes and 

return to the Study List. 
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Auto Open Priors 
 
All users with permission to view studies have the ability to 
manually open a patient’s prior studies through the Image 
Viewer interface. If you would like to have a patient’s prior 
study automatically opened when the viewer launches, you 
simply need to enable the Auto Open Priors feature. 
 
Which study opens automatically will depend on the Auto 
Open settings which can be found in your Image Viewer 
Settings control panel. For example, we can have the last 
study from the same modality opened, or the last study of 
the same body part. 
 
► To enable the auto open priors feature 
 
1. Left-Click on the Settings tab. 
2. Left-Click on the Auto Open Priors node to expand the 

Auto Open Priors settings. 
3. Select “On” dropdown list box. 
4. Left-Click on the Save button to save your changes and 

return to the Study List. 
 
 

 
 
 
☼ See Chapter 11:  Image Viewer Settings for more 
information on configuring your Auto Open Priors settings. 
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Filters Menu 
 
Through this interface, the user can create, modify, and 
delete search filters. Users will typically apply their filters 
(search criteria) to the study list, one at a time. This can 
become cumbersome if the user is constantly filtering the list 
for multiple criteria, such as date, modality, and referring 
physician. 
 
Client Worklist and Web Worklist have a saved search filters 
feature. These saved search filters make is easy for the user 
to apply a complex set of search criteria to the study list with 
the click of a button. See Chapter 3:  The Study List Screen 
for details on applying your saved search filters. 
 
 

 
 
 
☼ In order to create saved search filters, you must be logged 
into the Web Worklist application. 
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► To add/create a study list filter 
 
1. Left-Click on the Settings tab. 
2. Left-Click on the Filter Menu node to expand the filter 

menu settings. 
3. Enter a name for your filter in the New Filter Name 

textbox. 
4. Enter criteria in the remaining fields as needed. 
5. Select a user name in the Save For User dropdown list 

(only the Admin users will have this option). 
6. Left-Click on the Add Filter button. 
 
► To edit a study list filter 
 
1. Left-Click on the Settings tab. 
2. Left-Click on the Filter Menu node to expand the filter 

menu settings. 
3. Select a filter in the Filter Name dropdown list. 
4. Modify your fields as necessary. If you make a mistake 

and would like to cancel you changes, Left-Click on the 
Cancel Changes button. 

5. Left-Click on the Update Filter button. 
 
► To delete a study list filter 
 
1. Left-Click on the Settings tab. 
2. Left-Click on the Filter Menu node to expand the filter 

menu settings. 
3. Select a filter in the Filter Name dropdown list. 
4. Left-Click on the Delete Filter button. 
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Notes on adding and editing filters: 
 

• Only the “Admin” Group will be able to save filters for 
other users. All other groups can only create filters for 
themselves. 

• Hold down the CTRL key to make multiple selections 
in any of the list boxes (i.e. Body Parts, Modalities). 

• To deselect an item from your list, simply hold down 
the CTRL key and Left-Click on the item. 

• If you would like to deselect all items in your list, Left-
Click on the first entry in the list. This entry will appear 
as a blank space.   
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Chapter Five 

Dictation and Transcription 
 
This chapter explores Opal-RAD’s built-in Dictation and 
Transcription module. We will examine in detail the process 
of created radiology/exam reports for the studies loaded on 
the PACS. 
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Introduction 
 
The Dictation/Transcription Module of Opal-RAD allows the 
Reading Physician and Transcriptionist to work in unison to 
create and approve radiology/exam reports for study’s 
loaded on the PACS. 
 
As mentioned earlier in Changing the Status of a Study, 
each study loaded on the PACS is initially assigned a status 
of “Incomplete.” For those users who do not use the built-in 
Dictation/Transcription module, the incomplete studies will 
be validated to “Unread,” and then eventually marked as 
“Read” by the reading physician. 
 
But when the Dictation/Transcription module is used, the 
study’s life-cycle does not end after the study has been read. 
Rather, it ends after a study’s exam report has been 
approved and electronically signed by the physician. It is 
through the Dictation/Transcription module that we will reach 
that goal. 
 
We start by recording a dictation file and saving it with the 
exam. Then a transcriptionist will listen to the saved file, 
transcribe it, and send it back to the physician for approval. 
The physician will then determine the accuracy of the 
transcribed report and choose to approve or not approve it.  
 
In the following pages we will explain how this multi-stage 
process works. But first please refer to the diagram on the 
next page, as it illustrates the workflow process defined 
above. 
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Opal-RAD Workflow 
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Dictating a Study 
 
Dictation may be created from both the Image Viewer and 
the Transcription module. The dictation toolbar has a play, 
pause, stop, and record button for creating and listening to 
your dictations. There is also a status window and counter 
for providing feedback to the user.  
 
The Dictation control works seamlessly with the Philips 
Speechmike handheld recorder. The play, pause, stop, 
record, fast-forward, and rewind functions can all be 
accessed through the Speechmike control. 
  
 

 
 
 
► To record dictation 
 
1. Open your study in the Image Viewer, or Left-Click on the 

study’s Transcription button from the Web Worklist. 
2. Left-Click on the Record button (circle). 
3. Speak clearly into the microphone. To pause the 

recording, Left-Click Record again. 
4. When you have finished dictating, Left-Click on the Stop 

button (square). 
 
► To listen to your recorded dictation 
 
1. Open your study in the Image Viewer, or Left-Click on the 

study’s Transcription button from the Web Worklist. 
2. Left-Click on the Play button (triangle). 
3. Any recorded audio will begin to play. 
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4. When you have finished listening, Left-Click on the Stop 
button (square). 

 
 
After dictation has been created, it is important that it be 
uploaded back to the PACS server. If you have recorded 
your dictation using the Transcription module, you simply 
need to Left-Click on the Save Dictation button to save the 
current audio file and upload to the PACS. 
 
If you have used the Image Viewer to create the dictation, 
you simply need to close the Image Viewer to save and 
upload the dictation. 
 
Please note that if the user has disabled the Ask on Close 
feature, then they will be prompted to upload the dictation. 
To do so, simply select Yes in the dialog box. The 
“uploaded” dictation will be sent back to the PACS server 
where it will be saved. 
 
If you chose No in the previous step, you will then be given a 
second chance to save the dictation. Rather than saving the 
dictation on the PACS server, your file will be saved on the 
local hard drive. 
 
If the study is then reopened on the computer with the saved 
dictation, the user will be prompted to load the dictation into 
memory. 
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► To start a new dictation 
 
1. Open your study in the Image Viewer, or Left-Click on the 

study’s Transcription button from the Web Worklist. 
2. Left-Click on the New Dictation button (down arrow) and 

select New Dictation from the menu. 
3. Left-Click on the Record button (circle). 
4. Speak clearly into the microphone. To pause the 

recording, Left-Click Record again. 
5. When you have finished dictating, Left-Click on the Stop 

button (square). 
 
 
☼ If you start a New Dictation, any previously unsaved 
dictation will be erased. Please see previous topic for more 
information on closing and saving dictation. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 70 

Transcribing Dictation 
 
After dictation has been added to a study, you can transcribe 
it using the Transcription module. Although Dictation can be 
access from from both the Web and Client Worklists, the 
Transcription module is only accessible through the Web. 
 
The Transcription module contains both a text editor and the 
Dictation control (see previous section for usage). The text 
editor, is similar in design to many word processing 
application, such as Microsoft Word. There are controls for 
aligning, resizing, and reformatting your text.  
 

  

 
 
 
► To transcribe your dictations 
 
1. Left-Click the Transcription icon (above) next to the study 

to open the Transcription window. 
2. Use the Dictation toolbar to listen to your dictation (see 

previous section for instructions), and enter your 
transcription into the text editor. 

3. Left-Click on the Submit button to save. 
 
 
☼ Only users who are members of the Transcriptionist 
Group will have access to the Submit for Approval and 
Save Transcription functions. 
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Transcription window (Transcription user) 
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Approving Transcribed Reports 
 
Once the reports have been transcribed, it is then up to the 
physician to approve the reports. Approving the report is 
then simply a matter of opening the Transcription module, 
reading the report, and selecting the Approve button. 
 
► To approve a report 
 
1. Left-Click the Transcription icon next to the Transcribed 

study to open the Transcription window. 
2. Make any changes to the text as needed. 
3. Left-Click on the Approve button to approve the report 

and close the Transcription window. 
4. Optionally, you may select the Approve & Next button to 

approve the current report, and open the next 
Transcribed study in the Transcription window. 

 
 
Once approved, the report will be electronically signed with 
the approving physician’s signature, and the study’s status 
will be changed to “Approved.”  
 
 
☼ If Auto-Fax feature is enabled, a copy of the report will be 
faxed to the referring physician’s fax number. 
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Transcription window (Radiologist user) 
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Addendums 
 
Even after approval, the physicians and transcriptionist have 
the ability to go back to the report and create addendums. 
Addendums are used to either correct a mistake that may 
have been overlooked in the approval process, or to insert 
information that may have been unavailable at the time the 
report was initially constructed.  
 
► To add a dictation addendum 
 
1. Left-Click the Transcription icon next to the Approved 

study to open the Transcription window. 
2. Use the Dictation toolbar to create to your dictation (see 

previous section for instructions). 
3. Left-Click on the Save Dictation button to save. 
 
► To add a transcription addendum 
 
1. Left-Click the Transcription icon next to the Approved 

study to open the Transcription window. 
2. Left-Click on the Add Transcription Addendum button. 
3. Enter your transcription into the text editor. 
4. Left-Click on the Addendum Submit For Review button 

to save the transcription and close the window. 
 
 
Once a dictation addendum is saved, the study will revert 
back to the Dictated status. Once a transcription addendum 
is submitted, the study will revert back to the Transcribed 
status. 
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Transcription Templates 
 
To make the job of entering long or repetitive sections of 
transcription easier, users can utilize the templating feature 
of the Transcription module. Templates are especially useful 
when dealing with what are referred to as “normal” reports. 
    
► To create a template 
 
1. Left-Click the Transcription icon next to any study that is 

of the same modality as the type of template you would 
like to create (i.e. CR, CT). 

2. Enter your transcription into the text editor. 
3. Left-Click on the Save Template button (circled). The 

Manage Template window will appear. 
4. Enter a name for your template in the textbox and Left-

Click the Save button. 
 

 
 

 
 
☼ The saved template will be associated with whichever 
modality was used to create it. 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 76 

 ► To load a saved template 
 
1. Left-Click the Transcription icon next to the study you are 

creating transcription for on the Study List to open the 
Transcription window. 

2. Left-Click on the Templates dropdown list, and select a 
template. The text of the template will automatically load 
into your text editor. 

3. If you do not see your named template in the list, place a 
check in the box labeled All, and then repeat Step 2. 

 
► To delete a saved template 
 
1. Left-Click the Transcription icon next to any study on the 

Study List to open the Transcription window. 
2. Left-Click on the Save Template button. 
3. Left-Click on the Delete tab. 
4. Select the template from the dropdown list box. 
5. Left-Click on the Delete button. 
 
► To update a saved template 
 
1. Left-Click the Transcription icon next to any study on the 

Study List to open the Transcription window. 
2. Enter your transcription into the text editor. 
3. Left-Click on the Save Template button. 
4. Left-Click on the Update tab. 
5. Select the template you wish to have updated with the 

current transcription text from the dropdown list box. 
6. Left-Click on the Update button. 
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Auto Correct 
 
When active, the Auto-Correct feature of the Transcription 
window will automatically replaced one word or phrase with 
another pre-defined word or phrase. For example, you can 
have the word “USA,” replace with the phrase “United States 
of America.” 
   
► To create an auto-correct entry 
 
1. Open a Transcription window. 
2. Enter the word(s) you wish to use as your auto-correct 

phrase into the Transcription window’s text editor. 
3. Using the mouse, highlight the entire auto-correct phrase. 
4. While holding the CTRL key, press the E key. The Auto-

Correct window will appear. 
5. Enter your replacement text in the Expansion textbox. 
6. Left-Click the Update button to save your entry and close 

the window. 
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► To remove an auto-correct entry 
 
1. Open a Transcription window. 
2. Enter the word(s) you wish to use as your auto-correct 

phrase into the Transcription window’s text editor. 
3. Using the mouse, highlight the entire auto-correct phrase. 
4. While holding the CTRL key, press the E key. The Auto-

Correct window will appear. 
5. Delete the replacement text from the Expansion textbox. 
6. Left-Click the Update button to save your entry and close 

the window. 
 
 
☼ By default, all auto-correct entries are available to all 
transcription users. If, however, you wish to create an entry 
for only yourself, uncheck the Global checkbox before 
clicking Update. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 79 
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Chapter Six 

Advanced Tools 
 
This chapter explores some of the more advanced viewing 
features found in the Opal-RAD Client Worklist.  Some 
features are in the Web Worklist. 
 
 

Creating a Patient Disc (CD Burning) ...................... 
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Creating a Patient Disc (CD Burning) 
 
► To burn a patient study to a CD 

 
1. Launch the Client Worklist Study List screen. 
2. Highlight the Study you intend to burn to a CD by Left-

Clicking on the record. 
3. Left-Click on the CD Burn button, which appears at the 

bottom of the Study List screen. 
 

 
 

4. The Opal CD Burn window (see the following page) will 
then appear. In this window, select the study you wish to 
burn by Left-Clicking on the check box in the left-most 
column. 

5. Left-Click on the Start Burning button to commence the 
burning process 

 
 
Please note that CD burning is a system-intensive 
process and requires the entire computer’s processing 
to achieve.  It is therefore necessary to wait while until the 
CD is complete before continuing to use the Client Worklist.  
With current recording technology and speeds, most discs 
are complete within three minutes.  Particularly large exams 
may take more time to complete. 
 
Also note that Patient CDs can only be created one at a time 
in the Client Worklist. 
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If this is not sufficient for your institution’s needs (perhaps 
you need to create large numbers of CDs, or cannot have 
your reading interrupted by the CD burning process), please 
consider either purchasing a separate workstation devoted 
to creating CDs, or purchasing an Opal-RAD CDR Server to 
automate the process.  (For more information please contact 
Viztek, Inc.) 
 
☼ Burning a CD is only available through the Client Worklist 
and requires that the workstation have a CD-Recordable 
drive installed and configured. Please contact your Viztek 
support staff for any questions. 
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Importing Studies 
 
There are three options for importing studies/images into 
your PACS server. You can import a folder, individual files, 
or a DICOM directory structure. To access any of these 
import options you must first click on the Import CD button 
to open the Opal Import dialog (pictured below). 

 

 
 

 
► To import a folder containing DICOM images 
 
1. Left-Click on the Select Folder to Import button. 
2. Locate the folder you wish to import in the Browse for 

Folder dialog and select OK. 
 
► To import individual DICOM images 
 
1. Left-Click on the Select Files to Import button. 
2. Locate and then highlight the DICOM files you wish to 

import in the dialog and select Open. 
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► To import a DICOM directory structure 
 
1. Left-Click on the Open DICOMDir button. 
2. Left-Click the Open DICOMDir button in the dialog that 

appears (pictured below).  
3. Locate and then highlight the DICOMDIR file in the dialog 

and select Open. The Open dialog will close. 
4. Highlight the Patient, Study, Series, or Image node in the 

text box and click the Add To List button. 
5. Repeat steps 2, 3, and 4 for each DICOM structure you 

wish to import, and then click OK when you are finished. 
 

 
The DICOMDIR file contains the directory structure for your 
DICOM data. This includes Patient, Study, Series, and 
Image data. Be aware that when selecting a node (Step 4), 
only those nodes and their child nodes will be added to your 
import list 
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Importing Scanned Documents 
 
The Client Worklist has a feature which will allow you to 
import a scanned document into a study on your PACS 
server. This is useful for attaching exam reports, or other 
medical documents, to their corresponding exams. 
 
All that is required for the scanning feature is for a document 
scanner to be connected to and installed on the machine 
running the Client Worklist application. 
 
► To import a scanned document 
 
1. Highlight the Study you attach the document to by Left-

Clicking on the record. 
2. Left-Click on the Scan Paper button (Fig. 1). 
3. Load your document into the scanner, and Left-Click on 

the Scan button. 
4. When you are finished scanning documents, Left-Click 

on the Finished button. 
 
 
If the Client Worklist detects that you have more than one 
scanner installed on the computer, you will be prompted to 
select the correct scanner from the Select Source dialog 
(Fig. 2). 
 

    
Fig. 1                                 Fig. 2 
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Importing JPG Files 
 
In some cases, a patient may bring in a CD which contains 
medical images that are not in the DICOM format. The Client 
Worklist has the ability to import saved JPEG images into a 
study on your PACS. The only prerequisite for importing the 
image is that they are saved in a JPEG format. 
 
► To import a JPG image 
 
1. Highlight the Study you will be adding the images to by 

Left-Clicking on the record. 
2. Left-Click on the Import JPG button. 
3. Select one or more images in the Open Import Image 

dialog, and Left-Click Open (Fig. 1).  
4. Enter a Series Description in the text box (Fig. 2). 
5. If you selected multiple images in Step 3, and would like 

all of the images in one series, place a check in the 
checkbox. 

6. Left-Click on the OK button. 
 

 

    
Fig. 1                                    Fig. 2 

 
 
 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 87 

Send (“Push”) an Exam 
 
Sending a study to another PACS server is very simple to do 
once you have configured your recipients. 
 
► To send a study to another server 
 
1. Left-Click on the study to highlight it. 
2. Left-Click on the Send button at the bottom of the screen 

(Client only), or right click on the image and choose 
Print. 

3. Left-Click on the button that corresponds to the 
destination (Web Worklist), or select a location in the 
Locations dropdown (Client Worklist) and click the Send 
button.  
 

       
               Web Worklist                     Client Worklist 
 
After selecting the appropriate recipient, the screen 
disappears and the transfer of the exam is initiated in the 
background. No further user interaction is needed to 
complete the transfer, and it is not necessary to wait for one 
transfer to finish before initiating another. 
 
☼ Please see Chapter 11:  Web Worklist Administration for 
details on creating your send destinations. 
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Print to Film 
 
Printing to film is available through both the Client and Web 
Study Lists. When printing from the Client, the user has the 
ability to select which images will be sent to the printer, and 
which will not. When printing through the Web, the entire 
study will be sent to the printer. 
 
► To print images to film 
 
1. From the Study List screen, Right-Click on the study and 

choose Print.  
2. Select a DICOM printer from the Available Printers list 

box at the top of the dialog. 
3. Place a Left-Click the checkboxes next to any series 

and/or images you wish to print (Client Study List only). 
4. Configure any other options as desired (see next page 

for available options). 
5. Left-Click on the Print button. 
 

 
Client Study List DICOM Print Window 
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The Print to Film window offers many options for defining the 
layout of the printed images. 
 
Print to Film Options: 
 

• Layout:   Choose a layout for the printed images by 
clicking any one of the layout buttons.  The supported 
layouts include common configurations such as “2 X 
4”, indicating 2 columns by 4 rows. 

• Copies:  The number of copies of the film. 
• Priority:  Change the priority of the print job. A higher 

priority job will be completed first. 
• Orientation:  Print in portrait or landscape. 
• Actual Size:  Prints image in actual size, rather than 

taking up the entire piece of film. 
• Trim Box:  Border around image. This is a printer 

specific feature. 
• Smart Rotate:  When this option is selected, a 

landscape image will always print landscape.  A 
portrait image will always print portrait. 

• Burn in Overlays:  Select this option to “burn in” the 
overlay information into the images so that they print 
to film. 

• Burn in annotations:  Select this option to “burn in” 
any annotations you’ve made so that they print to film. 
This includes markers, text, and measurements.  

 
 
☼ Please note that the Web Worklist DICOM Print window 
does not contain an image preview feature. 
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Comparing Studies 
 
By using the Client or Web Worklist you have the ability to 
compare one study with a previous study from that same 
patient. This will require that you select two studies, one 
from the Study List and one from the Patient Studies 
Window.  
 
► To compare two exams 
 
1. Left-Click on a study in the Study List. The study will 

appear highlighted, and any previous exams for this 
patient will appear in the Patient Studies Window. 

2. Left-Click on a study in Patient Studies Window. 
3. Left-Click on the Compare button. This will bring up the 

Viewing Window. 
4. On single monitor systems you will see two groups of 

thumbnail images in the Series/Stacks window. Each 
group will have its own study header as in the example 
below. On dual monitor systems, each of your studies will 
open on its own monitor. 
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5. Choose the vertical or horizontal split view, which is in 

the top right corner of the screen or the View menu. 
 

 
 

6. Double-click or drag-and-drop the first image or series 
into the first pane. 

7. Left-Click on the header information of the second study 
to bring up the second studies images. 

8. Double-click or drag-and-drop the second image or 
series that you want to view in the second pane. Now 
both images can be manipulated. 

9. To return to the Worklist screen, Left-Click on the “X” in 
the upper right corner of the screen. 
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Chapter Six 

Patient/Study Administration 
 
This chapter will explore the set of tools used by the 
administrator that will allow him or her to manage studies in 
the PACS. These tools and functions are only available from 
the Client Worklist, not the Web Worklist. 
In order for the user to perform the functions described in 
this chapter, he/she must have the appropriate permissions. 
These permissions are created and assigned by the 
administrator through the Web Worklist Administration 
control panel. 
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Edit Patient and Study Information 
 
From time to time it may become necessary to edit the 
information contained within PACS to more accurately reflect 
contents of the data and or images contained within. This 
may require modifying a Patient’s demographics (i.e. Name, 
DOB, or Gender), or a Study’s details (i.e. Description, 
Referring Physician, or Body Part). 
 
When a patient’s demographics are modified, all of the 
patient’s associated studies will be updated to reflect the 
new changes. If a study’s details are modified, only that 
study will be updated. 
 
► To edit the a patients demographics 
 
1. Right-Click on any study for the patient to be modified on 

the Client Study List screen and then Left-Click on Edit 
Patient from the context menu. 

2. Modify the information as needed and then Left-Click on 
the Save button when finished. 

 
► To edit a study’s details 
 
1. Right-Click on the study to be modified on the Client 

Study List screen and then Left-Click on Edit Study from 
the context menu. 

2. Modify the information as needed and then Left-Click on 
the Save button when finished. 
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Patient Editor 

 
 

 
Study Editor 
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► To reassign a study to a new patient 
 
1. Right-Click on the study and then Left-Click on Edit 

Study from the context menu. 
2. Enter the new Patient ID in the Patient ID textbox, and 

press the TAB key. 
3. Enter values for the patient’s Name, DOB, and Gender. 
4. Modify any other information as needed and then Left-

Click on the Save button when finished. 
 
 
Notes on editing patient and study information: 
 

• If while editing a study’s details, you do not see your 
desired entry in the dropdown list boxes, you may 
click Add to activate the manual text entry feature. 
Any newly added entries will then be available the 
next time the Study Editor is opened. 

• If you attempt to change a patient’s ID, while using 
the Patient Editor, be aware that the ID must be 
unique. If the ID is in use by another patient, you will 
receive a warning dialog. 
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Merging Patient Studies 
 
Each study in the study list is associated with a patient 
name. There may come a time when one of your patients 
has studies in the system under two different names, such 
as a maiden name and married name. 
 
Ideally, you would want to consolidate, or merge, these 
studies under the one patient. By doing this, it would then be 
easier to locate a patient’s previous exams using the Patient 
Studies Window. Merging studies is simply a matter of 
associating the correct Patient ID to your study. 
 
► To merge studies under one patient 
 
1. Right-Click on the study and then Left-Click on Edit 

Study from the context menu. 
2. Enter the Patient ID for the patient you are assigning the 

study to in the Patient ID textbox. 
3. Press the TAB key on your keyboard or Left-Click on any 

other field or object in the editor window. A dialog box will 
appear asking you to confirm your choice. 

4. To confirm your choice, click Yes in the dialog box. 
5. Left-Click the Save button to save your changes and 

close the study editor. 
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Creating a New Study 
 
Periodically you may want to create a new, empty study in 
the PACS. With these empty studies, you can then import 
graphics, scanned documents, or acquire images from a CR 
scanner. 
 
► To create a new study 
 
1. On the Study menu, select Create New Study. 
2. Enter values for all require fields (those marked with an 

asterisk). 
3. Left-Click the Save button. 
 

 
 
 
If you would like to create a study for a preexisting patient, 
and do not wish to reenter the patient’s demographics, 
simply Right-Click on a study for the patient, and then Left-
Click on Patient - New Study.  
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Deleting and Purging Studies 
 
In order to remove a study from your study list it must first be 
marked for deletion. This process is comparable to placing 
items in the Recycle Bin on a Windows-based system. 
 
In order to permanently remove a study, it must be “purged.” 
In Windows parlance, this would the equivalent of “emptying 
the Recycle Bin.” 
 
► To mark a study for deletion 
 
1. Right-Click on the study in your Study List. 
2. Left-Click on Delete Study from the pop-up menu. 
 
► To purge your deleted studies 
 
1. On the Study menu, select Purge. 
2. In the Purge Study window that appears select each 

study you wish to purge. 
3. Left-Click on the Purge Study button. 
4. To confirm your choice, click Yes. 
 
We can distinguish “deleted” studies from other studies on 
the list by their status type (i.e. Unread, Read). We can un-
mark a study for deletion by changing the status, just as we 
can “restore” items placed in the Recycle Bin.  
 
► To un-mark a study for deletion 
 
1. Right-Click on the study in your Study List. 
2. Left-Click on Unread from the pop-up menu. 
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Deleting Study Images 
 
Using the Client Study List, the end user can delete 
individual images or entire series of images from a study. To 
do this, you must first open the Delete Series or Image 
dialog utility (see following page for screenshot). 
 
► To delete a series of images 
 
1. Left-Click on the study in your Study List so that it is 

highlighted. 
2. On the Study menu, select Delete Study Image. The 

Delete Series or Image Utility will open. 
3. In the Series panel, Left-Click on the checkbox next to 

the series you wish to delete. 
4. Left-Click on the Delete Series button. 
5. To confirm your choice, click Yes. 
 
► To delete individual images 
 
1. Left-Click on the study in your Study List so that it is 

highlighted. 
2. On the Study menu, select Delete Study Image. 
3. In the Series panel, Left-Click on the series which 

contains the image(s) to be deleted. The series should 
now be highlighted. 

4. In the Images panel, Left-Click on the checkbox next to 
the image you wish to delete. 

5. Left-Click on the Delete Image button. 
6. To confirm your choice, click Yes. 
 

 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 101 

 
Delete Series or Image Utility 

 
 
To preview an image, prior to deletion, Left-Click on the 
image in the Images panel. After a brief moment, the image 
will load inside the preview window (as shown above). 
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Merging Images:  Overview 
 
Every study which appears in your study list is assigned to a 
patient. These studies may contain one or more series, 
which in turn may contain one or more images each. This 
hierarchy of ownership is illustrated in the outline below. 
 
 Patient 

• Study 
♦ Series 
 Image 

 
 
The Client Worklist contains a utility that will allow the end 
user to quickly and easily move images from one study to 
another, thereby reassigning ownership of the images. This 
Merge Utility allows us to move Studies, Series, or Images. 
 
We can individually move images into a study for the same 
patient, or for a new patient. We can also move an entire 
series of images into another study. At which point we can 
leave the series intact, or combine it with a pre-existing 
series. 
 
The following chart displays the methods by which you may 
reassign images in the merge module: 
 
Object Can Be Reassigned to: 
Study:  Studies, or Patients 
Series: Patients, Studies, or Series 
Images: Patients, Studies, or Series 
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To further illustrate the PACS object hierarchy we have 
included another sample outline for the fictitious John Doe 
patient. In this example, John Doe has two studies; one X-
RAY and one CT.  
 
These studies contain two series each. Both X-RAY series 
contain only one image each, while both CT series contain 
many images each. 
 
 John Doe 

♦ Chest X-RAY 
 PA 

♦ Image 1 
 LAT 

♦ Image 1 
♦ Chest CT 

 Axial 
♦ Image 1 
♦ Image 2 
♦ Image 3 
♦ Image # 

 Coronal 
♦ Image 1 
♦ Image 2 
♦ Image 3 
♦ Image # 

 
 
☼ If you move a study into a study, or a series into a series, 
the objects contained within will be combined. 
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Merging Images: Step-By-Step 
 
To avoid confusion in the step-by-step instructions that 
follow, we will henceforth refer to the object to be moved as 
“Source,” and the object’s final resting place as 
“Destination.” 
 
The merge process begins by selecting either one or two 
patients/studies from the client work list. 
 
► To merge images 
 
1. From the Client Work List, Left-Click on the patient who 

owns the Source object. 
2. Hold down the CTRL key and Left-Click on the patient 

who will be receiving the Source object. (optional) 
 
 

 
Client Worklist 

 
 
3. Right-Click on a selected patient, and choose Merge 

Studies from the pop-up menu.  
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The Merge Studies window will appear. If you selected two 
studies in the previous step, then the first patient will appear 
in the top-most panel, and the second selected patient will 
appear in the bottom panel. 
 

 
Merge Studies Window 

 
 
If you only selected one patient prior to opening the merge 
window, then the bottom panel will not have a patient listed. 
In order to proceed with the merge process, you will first 
have to perform a patient search. 
 
 
☼ For instructions on searching, please see the topic on 
searching for patients immediately following this topic. 
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To the left of each patient name will appear a “+” symbol. If 
you click on the “+” symbol a hidden list of that patient’s 
studies will appear directly below the patient. And next to 
these studies will also appear a “+” symbol, which, once 
clicked, will expose the list of series contained within the 
selected studies. 
 
Once a node is expanded, the “+” symbol will be replaced 
with a “-“. 
 

 
Merge Window (expanded) 

 
 
4. Expand or collapsed the nodes as needed until you 

locate the Source object. 
5. Left-Click on the Source object so that it is highlighted. 
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6. Left-Click again and drag the object. As you drag the 
object, your cursor will appear to be dragging a tiny 
rectangular box with it. 

7. Drop the object on top of its destination. 
8. A dialog box will appear, asking you to confirm your 

action. The Source and Destination types, will dictate the 
dialog box that appears. Below are two examples. 

 

 
Series to Study 

 

 
Series to Series 

 
 
9. Left-Click on the Yes button to confirm your choice. 
10. When you are done moving images, Cleft-Click on the 

Done button to close the Merge Studies window. 
 
 
☼ Objects moved from the top panel can only be dropped 
into the bottom panel. Conversely, objects in the bottom 
panel can only be dropped into the top panel.   
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Below are two screenshots taken before and after a patient’s 
series was merged into another patient’s study. 
 

 
Before Merge 

 

 
After Merge 
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► To search for a patient using the merge utility 
 
1. Left-Click inside the blank space below the column you 

wish to search by. For example, if you wish to search for 
the patient by name, then Left-Click below the Patient 
Name column. 

2. Enter a value, and press Enter. 
 
 

 
Before 

 

 
After 
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Chapter Seven 

The Image Viewer Screen 
 
The Opal-RAD Image Viewer is a Diagnostic Quality image 
viewer where you will perform all of your image viewing and 
manipulation. The Image Viewer has a wide range of tools at 
your disposal to aid in the reading and diagnosis of images. 
This chapter will explore in detail the viewer, its tools, and 
their usage. 
 

An Overview of the Image Viewer Screen ............. 
Chapter Contents 

112 
The Image Window ................................................ 114 
The Series/Stacks Window .................................... 115 
Opening Images in the Image Viewer .................... 117 
Image Viewer Layout ............................................. 118 
Moving Images Between Panels ............................ 121 
Image Viewer Context Menus ................................ 122 
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An Overview of the Image Viewer Screen 
 
Let’s start by identifying this screen’s distinct parts. 
 
The Image Window constitutes the largest portion of the 
Image Viewer. This section of the screen is reserved for 
displaying the images, and can be modified to display the 
images in a variety of columns / rows configurations. This is 
also the area where you will manipulate the properties of the 
images and create annotations. 
 
The Series/Stacks Window is the smaller section on the 
leftmost side of the screen. The window displays a thumbnail 
image for every series (also referred to as a stack) in the 
study. These thumbnails also act as buttons (allowing you to 
quickly navigate between series.) 
 
The Toolbar and Menus are located at the top of the Image 
Viewer screen and sets up the remainder of the screen to 
aid in diagnostic viewing. The functions accessible from the 
menus and toolbar are relevant to manipulating images. 
 
 
☼ The individual toolbar functions will be discussed in 
greater detail in Chapter 5:  Image Viewing Tools. 
 
 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 113 

 
 

 
The images are displayed in rows and columns according to 
your selected layout, which can be changed by selecting one 
of the column layout buttons.  
 
The viewer can be changed to display your open images in a 
variety of configurations, including:  1x1, 1x2, 2x1, 2x2, 2x3, 
3x2, and 3x3. Please see the topic Image Viewer Layout in 
this chapter for more information. 
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The Image Window 
 
The largest area of the Image Viewer, and your central 
workspace, is the image window.  This is where image 
viewing and manipulation occurs.   
 
Note that only a limited number of images may be shown in 
viewing area at one time (only so many will fit), thus arrows 
above each series pointing left and right, will allow you scroll 
through the images in the series.  The scroll wheel and Span 
button (discussed later) will also accomplish this. 
 
 
Navigating through a series 
 
You can navigate through the images in a study by any of 
these methods: 
 

• Use the scroll bar at the top of the Image window 
• Use the UP ARROW and DOWN ARROW keys 
• Use the Span button on the toolbar 

 
The horizontal scrollbar at the top of the image will display 
the location of the image that is being viewed in relation to 
the number of images in the series (i.e. 9/12). 
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The Series/Stacks Window 
 
Leftmost on the screen is the Series/Stacks window.  For 
each series (or “stack”) of images that is currently loaded 
there is a thumbnail picture of the first image in that stack. 
 
A patient study may contain many series, all of which are 
loaded when the study is opened. To view a series, simply 
move the mouse cursors over the series thumbnail (in the 
Series window) you wish to view, and Double-Click on the 
thumbnail, or you may drag and drop images from the 
Series/Stack to the main Imaging Viewing window. 
 
To move from one series to the next, you may use the 
Previous Series and Next Series buttons located at the 
bottom of the viewing screen. 
 

 
 
 
The top of the Series/Stacks window contains study 
information. Right-Click on the information panel to view 
study notes, prior exams, or close the study. 
 

 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 116 

Note that only a limited number of thumbnail images may be 
shown in the series window at one time.  
 
► To scroll through the available series 
 
1. Left-Click on the up arrow (pictured) or down arrow 

provided above and below the thumbnails. 
 
If the up arrow is gray in color, you have reached the top of 
the list. If the down arrow is gray in color, you have reached 
the bottom of the list. When the arrow is gray then they are 
not usable.  
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Opening Images in the Image Viewer 
 
There are two methods for opening images/series in the 
Image Viewer. 
 
► To open an image - Method 1 
 
1. Double-Click on a thumbnail image on your series/stack 

window. 
 
When you open an image or series in this manner it will 
open up in the first available window panel. If there are no 
panels available, then it will open in whichever panel 
currently has focus. 
 
 
► To open an image - Method 2 
 
1. Drag-and-Drop the thumbnail image from the series/stack 

window onto the image window. 
 
The drag-and drop method will load your series in whichever 
pane you drop it into, whether there is already a series 
loaded or not.  
 
If, after placing your images on your panes, you wish to view 
only one image at a time, simply Double-Click it. The rest of 
your panes will disappear temporarily. Double-Click the 
image again to bring back your original layout. 
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Image Viewer Layout 
 
The image layout options allow you to specify the number 
of windowpanes that constitute your image window.  
 
► To modify your image layout 
 
1. Left-Click on one of the layout buttons on your toolbar. 

 

 
-or- 

 
2. On the View menu, choose Layout, and then select a 

layout (i.e. 2x2) from the pop-out menu. 
 

 
Example of a 2x2 image layout 
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On systems with multiple monitors, each image viewer 
window will have its own set of image layout buttons as 
described above, but there will also be a second set of 
layout buttons. This set of buttons (pictured below) will apply 
a selected layout to ALL monitors at once. 
 
► To modify your image layout of all monitors 
 
1. Left-Click on one of the layout buttons on your toolbar. 
 
 

 
 
 

  
                   Monitor 1                                  Monitor 2 
 
The example above shows a single study being opened 
across dual monitors. Note that the Series/Stack window for 
the second monitor is empty. Had we opened up two studies 
for comparison on a dual monitor system, the studies would 
have loaded on separate screens with their own 
Series/Stack windows. 
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The series layout options allow you to specify the number 
of rows and columns viewable within a series. Rather than 
splitting the window up into multiple panes for displaying 
multiple images/series, you are splitting up a pane so that 
you can display multiple slices from a given series. 
  
► To modify your series layout 
 
1. Right-Click on the series handle that is in the upper right-

hand corner of the windowpane. 
2. Select a layout (i.e. 2x2) from the pop-up menu. 
 
 

 
Example of a 2x2 series layout 

 
 
☼ Please see Chapter 9:  Image Viewer Settings for 
instructions on setting your default image or series layout. 
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Moving Images Between Panels 
 
The Series Handle may be dragged and dropped to move 
images. If a handle is dragged and dropped into another 
panel, the image will move from the original panel over to the 
new panel. If there is an image already loaded in that panel 
then this image will swap places with the one that was 
dropped, as in the example below. 
 
 

  
                   Before                                        After 
 
 
☼ Images may also be dragged from a panel on one monitor 
to a panel on another. 
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Image Viewer Context Menus 
 
Within the Image Viewer there are a number of areas for 
which there is a Right-Click context menu. The contents of 
the menu that appear upon Right-Clicking will depend on the 
item that was clicked. For example, if you Right-Click on an 
open image, you will see the following menu appear: 
 

 
 
 
Image Right-Click Options: 
 

• View FullScreen:  Hides the menus and toolbar 
controls to increase the viewable area of the viewer. 

• View Maximized: Temporarily shows the selected 
image in a one-by-one window panel. 

• View DICOM Values:  Shows a list of DICOM tags 
and descriptions sent from the modality. 

• View History:  Shows clinical history saved in the 
DICOM header. 
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• Add Image To Print Queue:  This adds the currently 
selected image to the paper print queue. 

• Add Series To DICOM Print Queue:  Adds the 
series for the currently selected image to the DICOM 
print queue. 

• Save Image As:  This allows you to save an image to 
a an external file. 

• Presets:  Applies a preset Window/Level to the 
current image. 

• Unsharp:  Applies an unsharp mask to the current 
image. 

• External Tools:  Sends the image to a pre-defined 
external application. 

• Set Key Image:  Creates a key image for the study 
• Add Image To New UNQ Study:  Adds current 

image to Pre-Op Study. 
• Delete Current Annotations:  Deletes the currently 

selected annotation. 
• Delete All Annotations:  Deletes all annotations on 

current image. 
• Delete All Annotations for Series:  Deletes all 

annotations that persist across multiple slices, such 
as the Spine Tool. 

• Link:  Links the selected series to any other series of 
the same view (i.e. Coronal, Axial). 

• Cine Tools: Opens or closes the Cine Toolbar control 
• Close Study:  Closes the current study. 

 
 
☼ The contents of this menu may change from image to 
image, depending on whether or not there are Annotations, 
Presets, installed External Tools, and so on. 
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Series Right-Click Options: 
 

• View Notes:  Opens a window to show any notes that 
have been added to the study. 

• View Related Exams:  Shows a list of prior exams 
that can be selected for viewing. 

• Close Study:  Closes the current study. 
 

 
 
 
Series Handle Right-Click Options: 
 

• Layouts:  Allows user to select a series layout view 
(i.e. 1x1 or 1x2, etc.). 

• Close Series:  Closes the selected series. 
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Chapter Eight 

Image Viewing Tools 
 
The Opal-RAD Image Viewer features a vast array of image 
manipulation tools to assist in diagnostic interpretation of 
medical images. Most of the tools described in this chapter 
have easy, one-click toolbar buttons to activate them.  They 
are also available from Images or Tools menu. 
 
 

Introduction ............................................................ 
Chapter Contents 

128 
Reset Image State ................................................. 129 
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Span/Scroll Images ................................................ 139 
Display Management ............................................. 140 
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Show or Hide Study Overlays ................................ 150 
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Introduction 
 

 
Image Viewing Tools buttons 

 
Each topic in this chapter will define each of the viewing 
tools that are available in the Image Viewer, list the ways to 
activate it (toolbar button, menu entry, etc.), and explore its 
usage. Some of the tools, such as the Magnify, Zoom, and 
Span tool, must be enabled to use. After you have finished 
using the tool you can disable it by: 
 
► To deactivate an active tool 
 
1. Left-Click on another tool. 
 
-or- 
 
2. On the Tools menu, Left-Click on None. 
 
-or- 
 
3. Left-Click that same tool again (from either the menu or 

the toolbar). 
 
☼ If you disable a tool with Method 3, then your default tool 
will be enabled automatically. For CR and US studies, the 
Magnify Tool is the default tool. For MR and CT studies, the 
Span Tool is the default tool. 
 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 129 

Reset Image State 
 

  Reset Image State tool 
 
 
The Reset Image State is one of the most important tools 
because it allows the user to set the image back to its 
original state.  The Reset Image State tool is on the toolbar 
and is also an option in the Image menu. 
 
► To reset an image back to its saved state 
 
1. Left-Click on the image or series. 
2. Left-Click on the Reset Image State tool on the toolbar, 

or select Reset from the Images menu. 
 
Resetting an image applies to all images in a series. 
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Invert Contrast 
 

  Invert toolbar button 
 
Use this tool to invert the black and white pixel data, giving 
the image a “negative” appearance. 
 
  Activate the Invert Contrast tool from the toolbar or go to 
the Images menu and choose the Invert option.  
 
► To perform invert contrast 
 
1. Left-Click on the image. 
2. Left-Click on the Invert Contrast tool on the toolbar, or 

select Invert from the Images menu. 
 
► To reset the image back to normal contrast 
 
1. Left-Click on either the Invert Contrast tool or the Reset 

Image Properties tool. 
  
Invert contrast applies to all images in a series. 
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Change Orientation Tools 
 

  Rotate Images Left toolbar button   
 

  Rotate Images Right toolbar button 
 

  Flip Images Vertically toolbar button   
 

  Flip Images Horizontally toolbar button   
 
These tools are available from both the toolbar and the 
Images menu. 
 
These tools apply to all images in a series. 
 
To undo one of these tools use the Restore Image State 
button.   
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True Size (1:1) 
 

  One To One View toolbar button 
 
Use this tool to display the image in its true size, i.e., 1:1 
ratio. When in 1:1 mode, you can view every pixel that 
makes up the image. 
 
► To view an image in its true size 
 
1. Left-Click on the image or series. 
2. Left-Click on the 1:1 View tool on the toolbar, or select 

One to One from the Images menu. 
 
Note that the image may be too large for the viewing 
window, especially if you are viewing in multiple columns.  In 
this case, you may wish to change the number of columns, 
use the Zoom tool to shrink the size of the image within the 
window, or use the Fit To Window tool. 
 
One To One applies to all images in a series. 
 
☼ “True Size” refers to the actual size needed to display 
every physical pixel stored in the image data.  MR images 
will typically “shrink”, while larger images like CT and CR will 
expand. 
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Fit To Window 
 

  Fit To Window toolbar button 
 
Use this tool to expand or shrink an image so that it fits in 
the Image Viewing window. 
 
This tool is of assistance when viewing large images in 
multiple columns as it shrinks images to fit in these smaller 
windows and allows you to view the whole image at once. 
 
► To resize an image to fit in the viewable window 
 
1. Left-Click on the image or series. 
2. Left-Click on the Fit To Window tool on the toolbar, or 

select Fit To Window from the Images menu. 
 
Fit applies to all images in a series. 
 
☼ “Fit to Window” is the logical opposite of “True Size” 
(previous page.) 
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Magnify 
 

  Magnify toolbar button 
 
Use this tool to magnify parts of an image. This is in contrast 
to the Zoom tool, which will magnify the whole image.  The 
magnifying tool creates a temporary pop-up window that you 
can move over the image as you would a magnifying glass. 
 
To activate the Magnify tool, click the Magnify button on the 
toolbar or click the Magnify option from the Tool menu. To 
turn Magnify off, click the None option or another tool from 
the Tool menu. 
 
► To use the Magnify tool 
 
1. Activate the Magnify tool. 
2. Place the cursor over the image. 
3. Hold down the left mouse button.  Observe the pop-up 

magnifying window. 
4. Move the mouse around over the image and the 

magnifying window will follow your movements. 
5. Release the left mouse button and the magnifying 

window will disappear. 
 
☼ By default, the popup window uses a 2x magnification. 
For more information on adjusting the magnification factor, 
or the window’s size, please see the Chapter on Image 
Viewer Settings. 
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Zoom 
 

  Zoom toolbar button 
 
This tool is used to zoom the entire image “in” (for closer 
inspection) or “out” (view the whole image at once). The 
mouse cursor will change to the Zoom tool cursor once 
holding the left mouse button down. 
 
To use this tool, first activate the Zoom tool.  This is 
accomplished by clicking the Zoom option on the toolbar or 
in the Tools menu.  
 
► To perform the zoom 
 
1. Activate the Zoom tool. 
2. Place the cursor over the image. 
3. Hold down the left mouse button. 
4. Move the mouse up to zoom in, down to zoom out. 
5. Release the left mouse button. 
 
☼ As you zoom images in it may no longer be possible for 
the entire image to fit in the window, thus the Pan tool may 
be of some assistance in moving the image around. 
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Pan 
 

  Pan toolbar button 
 
Use this tool to move an image around within its display 
window. 
 
To activate the Pan tool choose the Pan entry from the Tools 
menu. 
 
► To perform a pan 
 
1. Activate the Pan tool. 
2. Place the cursor over the image. 
3. Hold down the left mouse button. 
4. Move the mouse in any direction; the image will follow 

your movements. 
5. When you are satisfied with the image’s placement, 

release the left mouse button. 
 
Pan applies to all images in a series. 
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Actual Size 
 

  Actual Size  
 
Use this tool to display the image in its actual (anatomical) 
size. NOTE:  The Actual Size tools will only work if the 
monitor has been calibrated. 
 
► To view the actual size 
 
1. Left-Click on the image or series. 
2. Select Actual Size from the Images menu.  
 
► To calibrate your monitor 
 
1. On the Settings menu, select Edit. 
2. Left-Click on the Local tab. 
3. Enter your display’s visible Width and Height (in 

millimeters) in the Monitor Calibration textboxes.   
4. Left-Click on Apply, or Left-Click on the OK button to 

save your changes. 
 
Actual Size applies to all images in a series. 
 
 
☼ Please see the Image Viewer Settings chapter for more 
information on calibrating your monitor(s). 
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Window and Level (Width & Center) 
 

  Window & Level tool 
 
This is the most basic and yet most important tool available, 
as it adjusts the window and level (also known as “width and 
center”, or simply brightness and contrast) of an image. 
 
Adjusting the window and level of an image allows for 
viewing different “levels” of an image, e.g., moving from 
bone to soft tissue. 
 
► To perform the Window & Level 
 
1. Place the mouse cursor over the image. 
2. Hold down the right mouse button. 
3. Move the mouse horizontally and/or vertically; the image 

is adjusted as you do so. 
4. When satisfied with the image, release the right mouse 

button. 
 
Vertical movement of the mouse adjusts the “window” and 
horizontal movement adjusts the “level.”  
Window & Level applies to all images in a series. 
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Span/Scroll Images 
 

  Span/Scroll Images tool 
 
The Span/Scroll Images tool is useful when looking at a 
study that contains series with multiple images (CT, MR, 
US.)  The tool allows the viewer to move through the images 
in a series. 
 
The Span/Scroll Images tool can be found in the toolbar and 
also as an option in the Tools menu.   
 
► To use the Span tool 
 
1. Left-Click on the Span/Scroll tool on the toolbar, or select 

Span/Scroll Images from the Tools menu. 
2. Move the mouse cursor on top of a series. 
3. Hold the left mouse button down and move the mouse to 

the left to go up a series (towards the beginning), or to 
the right to go down a series (towards the end.) 
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Display Management 
 

  Display Management tool button 
 
Many physicians prefer to display images a certain way each 
time they open a study. To expedite this process of 
displaying images you can use Display Management. The 
display settings, once defined, can be saved for the current 
study or for all studies of a certain type (i.e. MR, CT, US). 
 
► To save your display settings for all studies 
 
1. Left-Click on the Display Management tool and select 

Save. 
 
► To save your display settings for a single study 
 
1. Left-Click on the Display Management tool and select 

either Save For Study or Save As.  
2. If you selected Save As, enter a name in the textbox and 

select OK. 
 
► To apply your display settings to the current study 
 
1. Left-Click on the Display Management tool and select 

your saved display setting from the list. 
 
If the display setting was saved using the “Save For Study” 
option, select “Default” from the list. Any display setting 
using the “Save” option will be applied automatically the next 
time studies of this type are opened. 
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Mammography Layouts 
 
In a typical mammography screening exam, four X-Rays of 
the breast are acquired. In conventional practice, two views 
are obtained for each breast. The first is the Cranio-Caudal 
(CC) view.  The second view is called the Medio-Lateral 
Oblique (MLO) view. 
 
When viewing these Mammography studies in the Image 
Viewer, you will have access to a special set of tools and 
features that are not available with other study types. 
 
The tools include a custom toolbar (pictured below), which 
allows the user to quickly display various mammography 
images simply by selecting the corresponding layout button. 
 
 

. 
Mammography Layout Toolbar 

 
 
In the sample toolbar above, we are displaying a total of four 
layout buttons. They are as follows: Processed CC and 
MLO; Raw CC and MLO; Processed R/L MLO; and 
Processed R/R MLO (for comparison). 
 
The layout buttons that are displayed are image dependent. 
For example if your study only contains the CC view of the 
breasts, then only CC specific layout buttons will appear. 
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Below is a list of additional Mammography Layouts. This list 
is not comprehensive, as it does not show all possible 
permutations of the views available. 
 

  Processed R/L CC 

  Raw R/L CC and MLO 

  Processed R/L MLO  

 Processed R/L CC and MLO 

  Processed R CC 
 
To conserve space on the Image Viewer Toolbar, the 
Mammography Layouts Toolbar will be limited in length. If 
more layouts exist than can be shown, the Left and Right 
Arrows will allow you to scroll through the list of buttons. 
 
► To apply a mammography layout 
 
1. Open a Mammography study, by Double-Clicking on the 

study’s entry on the Study List. 
2. After the images have loaded, Left-Click on the 

Mammography Layout Toolbar button that corresponds 
to the view you would like displayed. 

 
☼ The currently selected layout’s name will appear at the 
top-left corner of the toolbar control. 
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When viewing multi-image layouts, such as a Processed 
Right and Left MLO, on a single monitor system, both 
images will display inside the viewing pane in a 1 x 2 
windows layout. When viewing multi-image layouts on a dual 
monitor system, each image will display in its own viewer. 
 
 

 
Single Monitor with L/R MLO 

 
 

   
Monitor 1                                  Monitor 2 
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Mammography Tools 
 
When viewing a Mammography study, you will notice that 
the behavior of some of the tools you are already familiar 
with has changed slightly. The Tools affected include the 
Zoom, Pan, Window and Level, and Magnify tools.  
 
The use of each of these tools on an open Mammography 
image results in a “mirror-like” effect which can be seen on 
its corresponding sister image. For example, if you adjust the 
Window and Level of the right breast in a CC view, the Left 
breast’s W/L will adjust as well. 
 
The tools and their affected changes are as follows: 
 

• Window and Level:  The W/L of both images will be 
adjusted simultaneously as the tool is used.  

• Magnify Tool:  When this tool is used, a second 
magnifying window will appear over the same region 
on the adjacent image.   

• Magnify Annotation:  When this annotation is placed 
on an image, a second magnifying box will appear 
over the same region on the adjacent image.   

• Pan Tool:  Both images will pan in the same direction 
(i.e. anterior, posterior, left, right). 

• Zoom Tool:  Both images (left and right) will zoom to 
the same location on the breast. 

 
 
☼ To learn more about the use of the tools listed above, 
please consult the appropriate topics within this chapter. 
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Image Overlays 
 

  Image Overlays tool 
 
Certain types of studies, such as CT or Mammograms, can 
contain embedded overlays. These overlays are actually 
saved as part of the DICOM header of the image files. The 
overlays, once visible, will appear as text or annotation on 
the images they are saved into.  
 
► To view embedded overlays 
 
1. Left-Click on the image which contains the overlay. 
2. Left-Click on the Images Overlay tool from the toolbar to 

turn on overlays.  
 

 
 The overlays have been enhanced to show detail 
 
 
☼ The Overlays button will only be visible if overlays have 
been detected for the image being viewed. 
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Context Tool 
 

  Context tool 
 
The Image Viewer’s Context Tool allows the user to locate a 
slice in one or more series by selecting a point on another. 
For example, if you select a point on a coronal image/slice, 
the context tool will automatically scroll to that slice on a 
related axial series. 
 
► To use the Context tool 
 
1. Open at least two series in the image viewer. 
2. On the Tools menu, select the Context tool. 
3. Place your cursor over one of the images, then click and 

hold the left mouse button. 
4. As you drag the mouse across the image, any related 

series will automatically scroll to the correct slice. 
 

 
The context tool has been enhanced to show detail 
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Hounsfield/Pixel Value 
 

  Hounsfield Unit tool 
 
The Hounsfield/Pixel Value tool will give the viewer a 
Hounsfield units reading if viewing a CT image and a pixel 
reading if viewing any other type of image. The tool activates 
a cross hair that will give you a temporary density reading at 
that precise point.     
 
► To use the Hounsfield tool 
 
1. On the Tools menu, select Hounsfield/Pixel Value. 
2. Move your mouse over the area to be measured and 

Left-Click to display the Hounsfield/Pixel value. 
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3D Cursor 
 

  3D Cursor tool 
 
The 3D Cursor is similar in functionality to the Context tool. 
When active, this will show you your relative position on one 
series with the series that currently has focus. This position 
is indicated by a small circular marker that will grow and 
shrink as we move the mouse across the images. 
 
For example, assume we have both an axial and coronal 
series displayed. If you move the mouse cursor up and down 
over the coronal, the corresponding marker on the axial 
series will grow or shrink in size. 
 
 As your position on the coronal moves further away from the 
slice that is displayed in the axial window, the circular marker 
will increase in size. Conversely, the marker will shrink in 
size as you move closer to the displayed axial slice. 
 
► To use the 3D Cursor tool 
 
1. On the Tools menu, select 3D Cursor. 
2. Move your mouse over an image. As you do so, you will 

a circular marker appear over any other open, related 
series.  
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Unsharp Masking 
 
Unsharp Masking is a technique, which processes an image 
into a clearer and more defined image.  In general, sharp 
parts of an image are sharpened and less defined areas 
become clearer.  It is a better technique than simply 
sharpening the image because the results are much less 
harsh. Unsharp Masking is most effective on large, CR 
images. 
 
► To use the Unsharp Masking tool 
 
1. Right-Click on the image, or Left-Click on the Tools 

menu. 
2. Select an entry from Unsharp pop-out menu. 
3. Wait a moment for the system to process the image. 
 
To “undo” the effects of unsharp masking and return the 
image to its original state, select the Unsharp Masking tool 
again and choose “Reset” from the pop-out menu. 
 
Unsharp Masking applies to all images in a series. 
 
 
☼ Unsharp Masking is strictly a viewing tool; therefore 
images cannot be saved with the unsharp masking 
enhancement. 
 
 
 
 
 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 150 

Show or Hide Study Overlays 
 
Overlays are the patient, study, or image data that appears 
on the image. This is not to be confused with the Image 
Overlays, which are saved in the DICOM header of some 
image files.  
   
► To show or hide overlays 
 
1. On the View menu, select Overlays. A check indicates 

that they are enabled, or press the “O” key on the 
keyboard. 
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Chapter Nine 

Annotations 
 
The Opal-RAD Image Viewer also features a large number 
of image annotation tools to futher assist in the diagnosis of 
your images. Most of the annotation tools described in this 
chapter have easy, one-click toolbar buttons to activate 
them. They are also available from the Annotations menu. 
 

Chapter Contents  
Introduction ............................................................ 153 
Line ........................................................................ 154 
Freehand ............................................................... 155 
Ellipse .................................................................... 156 
Rectangle/Box ....................................................... 157 
Arrow ..................................................................... 158 
Measure ................................................................. 159 
Angle...................................................................... 160 
Cobb Angle ............................................................ 161 
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Introduction 
 

 
Annotation buttons 

 
Annotating in Opal-RAD Image Viewer 
consists of adding text and graphical 
objects to enhance or isolate regions of 
interest within an image.  Annotations 
do not permanently alter the image, but 
are stored separately from the image 
data, and are held in a transparent 
layer atop the image.  (Think of a 
transparency sheet with writing that is 
placed over a picture.) 

 
It is not possible for annotations to 
damage the original image data, and 
they can be hidden at any time to allow 
full analysis of the image. Most of the 
annotation tools described over the 
next several pages have easy, one-
click toolbar buttons to activate them 
and are also available from the 
Annotation menu in the menu bar. 

 
Each topic below names an image annotation tool, lists the 
ways to activate it (toolbar button, menu entry, etc.), and 
explores its usage. 
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Line 
 

  Line tool button 
 
This tool creates a straight line on the image. 
 
► To use the Line tool 
 
1. On the Annotations menu, select the Line tool. 
2. Left-Click on an area of the image to set the line’s first 

endpoint. 
3. Move the mouse pointer to where the second endpoint 

will be (notice that a preview of the line is drawn while 
you move the mouse). 

4. Left-Click on an area of the image to set the line’s second 
endpoint. 
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Freehand 
 

 Freehand tool button 
 
This tool is used to draw freehand on the image.  With the 
tool you are able to draw any shape or figure that you desire. 
 
► To use the Freehand tool 
 
1. On the Annotations menu, select the Freehand tool. 
2. Move the mouse over the image to where you would like 

to start drawing. 
3. Hold down the left mouse button and drag the mouse.  As 

you move the mouse, the drawing will mimic your 
movements. 

4. Continue to draw as necessary. 
5. Release the left mouse button to end the freehand 

drawing. 
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Ellipse 
 

  Ellipse tool button 
 
This tool creates a (hollow) ellipse on the image.  This is 
often used to circle an ROI (region of interest). 
 
► To use the Ellipse tool 
 
1. Left-Click on the Ellipse tool on the Annotations toolbar, 

or select Ellipse from the Annotations menu. 
2. Left-Click on an area of the image to start the ellipse.  
3. Move the mouse pointer and observe the ellipse 

expanding.  Move the mouse such that the ellipse will 
enclose the ROI. 

4. Left-Click to set the ellipse in place. 
 
 
It is generally best to click a spot that is above and left of the 
ROI, as you will then drag the ellipse down and to the right to 
enclose the ROI.  It generally takes a few practice ellipses to 
master the technique. 
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Rectangle/Box 
 

  Rectangle/Box tool button 
 
This tool creates a (hollow) box on the image.  You can 
create a square or a rectangle of any ratio (tall, long, etc.) 
and is often used to indicate an ROI (region of interest). 
 
► To use the Rectangle/Box tool 
 
1. Left-Click on the Rectangle tool on the Annotations 

toolbar, or select Rectangle from the Annotations 
menu. 

2. Left-Click on an area of the image to start the box. 
3. Move the mouse pointer and observe the box expanding. 
4. Left-Click again to set the box. 
 
 
Your first click will set a corner of the rectangle in place. 
Generally, make your first click above and left of the ROI. 
This will set the top left corner of the box.  You then move 
the mouse down and right to draw the box and enclose the 
ROI. 
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Arrow 
 

  Arrow tool button 
 
This tool creates an arrow (or “pointer”) that will point at an 
area of the image. 
 
► To use the Arrow tool 
 
1. Left-Click on the Arrow tool on the Annotations toolbar, or 

select Arrow from the Annotations menu. 
2. Left-Click the mouse on an area of the image to set the 

pointer end of the arrow. 
3. Move the mouse and observe the trailing end of the 

arrow following your movements.  You can rotate the 
arrow around and shorten or lengthen the trailing end. 

4. Left-Click the mouse to set the other endpoint of the 
arrow. 
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Measure 
 

  Measure tool button 
 
This tool is used to measure straight-line distance (in 
millimeters) of an area in the image. 
 
► To use the Measure tool 
 
1. Left-Click on the Measure tool on the Annotations 

toolbar, or select Measure from the Annotations menu. 
2. Left-Click on the image to set the first end point of the 

ruler. 
3. Move the mouse to where the end point of the 

measurement will be and Left-Click to set the end point.  
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Angle 
 

  Angle tool button 
 
This tool is used to draw an angle and display the 
measurement of that angle. 
 
► To use the Angle tool 
 
1. Left-Click on the Angle tool on the Annotations toolbar, or 

select Angle from the Annotations menu. 
2. Left-Click on the image to set the vertex (center point) of 

the angle. 
3. Move the mouse to where the end point of the first vector 

should be and Left-Click to set it in place. 
4. Move the mouse to where the end point of the second 

vector should be and Left-Click to set it in place. 
5. The angle’s measurement will then be displayed. Move 

your mouse to reposition the angle and Left-Click a final 
time to set it in place. 

 
☼ Note that the ability to move the position of the 
measurement text allows you to leave the measured area 
uncovered and in full view. 
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Cobb Angle 
 

  Cobb Angle tool button 
 
This tool is used to find the angle where two lines intersect. 
 
► To use the Cobb Angle tool 
 
1. Left-Click on the Cobb Angle tool on the Annotations 

toolbar, or select Cobb Angle from the Annotations 
menu. 

2. Left-Click to set the first point for the first line. 
3. Left-Click to set the last point for the first line. 
4. Left-Click to set the first point for the second line. 
5. Left-Click to set the last point for the second line. 
6. A measurement now appears showing the angle where 

these two lines meet. Left-Click to set the angle 
measurement in place. 
 

Note that the ability to move the position of the measurement 
text allows you to leave the measured area uncovered and in 
full view. 
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Left and Right Marker 
 

  Left Marker tool 
 

  Right Marker tool 
 
These tools are used to label the image left or right.   
 
► To use the Left or Right marker tools 
 
1. Select the Left Marker or Right Marker tool button on 

the Annotations toolbar, or select the marker from the 
Annotations menu. 

2. Left-Click on an area of the image to start the label. 
3. Move the mouse pointer and observe the label 

expanding. 
4. Left-Click again to set the label. 
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ROI (Region of Interest) 
 

  Region of Interest tool button 
 
This tool creates an ellipse on the image, which is used to 
focus on a specific region of interest.  This tool is used to 
highlight a specific region and to compute information about 
the area inside of the ROI box. This information includes not 
only the Length are Area, but also the Minimum, Maximum, 
Mean, and Standard Deviation in Hounsfield Units. 
 
► To use the ROI tool 
 
1. Left-Click on the ROI tool on the Annotations toolbar, or 

select ROI from the Annotations menu. 
2. Left-Click on an area of the image to start the ROI ellipse.  
3. Move the mouse pointer and observe the ellipse 

expanding.  Move the mouse such that the ellipse will 
enclose the area for study. 

4. Left-Click to set the ROI ellipse in place. 
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Text 
 

  Text tool button 
 
This tool allows you to place typed text on the image.  Many 
doctors use this in conjunction with other tools, such as the 
arrow or ellipse, to explain the ROI or indicate opinions / 
readings. 
 
► To use the Text tool 
 
1. Left-Click on the Text tool on the Annotations toolbar, or 

select Text from the Annotations menu.  
2. Enter your text in the dialog box that appears. 
3. To move your cursor to a new line, hold down CTRL and 

press ENTER (the text dialog box can support up to 3 
lines of text). 

4. When you are done typing, click the OK button or press 
ENTER to close the dialog box. 

5. Left-Click on the area of your image where you wish the 
text to appear. 

 
► To edit the text annotation 
 
1. Enter Annotation Edit Mode (see next section). 
2. Double-Click on the textbox and the text dialog box will 

appear. 
3. Change the text as necessary and click the OK button or 

press ENTER when finished. 
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Magnify 
 

  Magnify tool button 
 
This tool allows you to draw a box around on an image, 
which will then magnify the contents of the enclosed area. 
  
► To use the Magnify tool 
 
1. Left-Click on the Magnify tool on the Annotations toolbar, 

or select Magnify from the Annotations menu. 
2. Left-Click on an area of the image to start the box. 
3. Move the mouse pointer and observe the box expanding. 
4. Left-Click again to set the box 
 

 
Magnify Annotation (at 2x) 

 
 
If you would like to increase or decrease the magnification 
factor of the magnify annotation, highlight the annotation 
(must be in Edit mode), and then press the “+” or “-“ key. 
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Print ROI 
 
Print ROI tool button 
 
This tool creates will allow you to create a Region of Interest 
on your image and then have that portion of the image 
printed to paper.. 
 
► To print a region of interest 
 
1. On the Annotations menu, select the Print ROI tool. 
2. Left-Click on the image to start the ROI box. 
3. Move the mouse pointer and observe the box expanding. 
4. Left-Click again to set the ROI box. 
5. Right-Click on the image and select Add Image to Print 

Queue. 
6. Left-Click the Print Queue button in the bottom left 

corner of the screen to open the Print Queue window. 
7. Select a layout and adjust any other options and then 

Left-Click on the Print button. 
 
☼ Only the first ROI placed on an image will be added to the 
Print Queue. If you need to print a second ROI from the 
same image, remove the first ROI. 
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Spine Labels 
 

  Spine Labeling tool button 
 
With the exception of C1 and S5, each of the Image Viewer’s 
Spine Labels has a menu option for labeling “Up” or “Down” 
the spine. The labels include the following: 
 
Cervical:  C1, C2, C3, C4, C5, C6, C7 
Thoracic:  T1, T2, T3, T4, T5, T6, T7, T8, T9, T10, T11, T12 
Lumbar:  L1, L2, L3, L4, L5 
Sacral:  S1, S2, S3, S4, S5 
 
► To use the Spine Labeling tool 
 
1. Left-Click on the Spine tool on the Annotations toolbar, 

or select Spine Labels from the Annotations menu. 
2. Hover over one of the 4 sub-menus and then select a 

marker from the pop-out menu. 
3. Left-Click on the image to place the first label. 
4. Continue Left-Clicking on the image until all of your labels 

have been placed. 
 
When you begin the labeling process you must continue until 
you reach either C1 or S5, depending on the direction you 
have chosen. For example, if you select “L2 - Down,” you will 
label your spine from L2 to S5. 
 
☼ Unlike most other annotations the spine labels will appear 
on all slices in a series 
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Cervical and Lumbar Curve 
 
Cervical and Lumbar Curve tool 
 
 
► To use the Cervical Curve tool 
 
1. On the Annotations menu, select the Cervical Curve 

tool from the Chiropractic sub-menu. 
2. Left-Click on the image to set your first point. 
3. Left-Click again to set your second point. 
4. Move your mouse to either side of the axis that is created 

between the two points and Left-Click to place the curve. 
 
► To use the Lumbar Curve tool 
 
1. On the Annotations menu, select the Lumbar Curve 

tool from the Chiropractic sub-menu. 
2. Left-Click on the image to set your first point. 
3. Left-Click again to set your second point. 
4. Move your mouse to either side of the axis that is 

created between the two points and Left-Click to place 
the curve. 
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Editing and Deleting Annotations 
 

  Annotation Edit Mode button 
 
The Image Viewer includes the ability to select, edit and 
delete previously created annotations. Before you are able to 
edit or delete an annotation you must first select it, and to do 
this requires that you enter into “Annotation Edit Mode.” 
 
► To enter Annotation Edit Mode 
 
1. Left-Click on the Annotation Edit Mode tool on the 

toolbar, or select Edit from the Annotations menu. 
 
► To select an annotation 
 
1. Enter Annotation Edit Mode (see above) 
2. Move the mouse over an annotation. Observe the 

annotation will light up when the mouse moves over it. 
3. Left-Click the annotation to select it. It will change colors 

and several little filled boxes (called “handles”) will 
appear on the annotation. 

4. The annotation is now selected. 
 
 
Now that our annotation is selected, we can edit it (i.e. 
reposition or resize it). There are two types of editing 
cursors. When the cursor has four arrows pointing in all 
directions, the user can reposition, or move, the annotation. 
When the cursor is an upward pointing arrow, the user can 
resize the annotation. 
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► To edit a selected annotation 
 
1. Select an annotation (see previous section). 
2. Move your mouse over the top of the selected 

annotation. 
3. If the cursor changes to an up arrow, you may Left-Click 

to grab the handle. Move your mouse to resize the 
annotation, and then release the button when you are 
done. 

4. If the cursor changes to a four-way arrow, you may Left-
Click to grab the annotation. Move your mouse, and then 
release the button to drop the annotation in place. 

 
► To delete an annotation 
 
1. Select the annotation (see previous section). 
2. Right-Click anywhere on the image and choose Delete 

Current Annotation from the context menu or press 
DELETE on your keyboard. 

 
► To delete all annotations 
 
1. Right-Click on the image. 
2. Select Delete All Annotations from the context menu.  
3. If the annotation persists across multiple slices, such as 

the Spine Labels, then select Delete All Annotations for 
Series. 

 
 
☼ Deleting all annotations from an image or series does not 
require that you first be in Annotation Edit Mode. 
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Saving Annotations 
 
In order to save any additions, deletions, or alterations to 
your image’s annotations, you must “Save” them to the 
database. There are two options for accomplishing this.  
 
You can use the auto-save feature of the viewer (see 
Chapter 9:  Image Viewer Settings for more details) or you 
can manually save your changes. 
 
► To manually save your annotations 
 
1. On the Annotations menu, select Save. 
 
 
☼ If the auto-save feature is disabled, and you do not 
manually save your annotations, all of your changes will be 
lost upon closing the study. 
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Chapter Ten 

Advanced Tools 
 
This chapter explores some of the more advanced viewing 
features found in the Opal-RAD Client Worklist.  Some 
features are in the Web Worklist. 
 
 

Cut-Lines ............................................................... 
Chapter Contents 
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Saving Images to a File ......................................... 182 
Sending an Image to an External Application ........ 183 
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Cut-Lines 
 
Cut-Lines are simply white lines that depict the intersection 
between images in a study. Cut-lines are controlled via the 
option found in the View menu.  This option allows the user 
to toggle between cut-lines on and cut-lines off. 
 

 
 

 
The cut-line has been enhanced to show detail 

 
 
☼ Note that cut-lines will only appear when the study 
contains intersecting images. 
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The Linking Series 
 
The Image Viewer has a feature that will allow you to link 
multiple image series, so that as you scroll through one 
series the other will follow. This is very useful for comparing 
similar series from the same study. 
 
► To link or unlink a series 
 
3. Left-Click on the series in your image window to select it. 
4. Right-Click on the series and select Link to activate the 

link, or Unlink to deactivate the link. You may also use 
the shortcut key “L” to achieve the same goal. 

5. Repeat steps 1 and 2 for each series that you wish to link 
or unlink. 

 
The word “Linked” with the letter “A” or “N” will appear at the 
bottom of each series you have linked. An “A” means that 
the series was linked successfully, an “N” means that it was 
not. If any of the series you have linked appear with an “N”, 
then all of your previous links will not function until you have 
unlinked the invalid series. 
 

       
Linked           Linked 

 
☼ Series will only link correctly if they are of the same body 
part and on the same plane (i.e. axial, coronal), but they do 
not have to contain the same number of images. 
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Key Images 
 
The “Key Images” feature is designed to allow the quick 
identification of particularly important images in a study.  The 
doctor reading the exam marks images, as “key” that are 
prominent in the study. A copy of each of these images is 
then placed in a separate thumbnail in the Series/Stacks 
window so that all of the key images in the study can be 
viewed quickly. 
 
Additionally, when key images 
have been marked, the series 
description will appear to be 
highlighted. 
 
The power of this tool is that, 
although the key images may 
reside in many separate series, 
the key image stack brings all 
of these images together into 
one stack, providing a more 
efficient read. 
 
► To show or hide a study’s key images 
 
1. Left-Click on Key Images just below the series 

description (pictured above).   
 
 
☼ The “Key Images” button inside the Image Viewer and the 
“K” button on the Study List will be highlighted when present. 
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► To Mark (Create) a Key Image 
 
1. Right-Click on the image and select Set Key Image, or 

press the “K” key on the keyboard. 
 

 
 
 
► To Unmark (Remove) a Key Image 
 
1. Right-Click on the original image that has a Key Image 

and select Unset Key Image, or press the “K” key on the 
keyboard. 

 

 
 

 
☼ The Unset option is only available when the correct image 
is right clicked on. 
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Creating a Pre-Op Study 
 
A Pre-Op study is a special type of study, which is created 
from one or more studies for a given patient. Creating one is 
simply a matter of opening a study in the image viewer and 
adding images. Once it’s created, additional images from 
any of that same patient’s previous studies may be added. 
 
Pre-Op studies will appear on your Study List screen under 
the Modality of UNQ (short for unique). These studies will 
appear at or near the top of the study list. If the new study 
does not immediately appear, you may Left-Click on the 
Study List’s Refresh button. 
 
► To add an image to a new Pre-Op study 
 
1. Right-Click on the image and select Add Image To New 

UNQ Study. 
2. Enter a description for the study in the dialog that 

appears and click the OK button. 
3. Enter a description for the image in the dialog that 

appears and click the OK button. 
 
► To add an image to an existing Pre-Op study 
 
1. Open a study from the patient with the existing Pre-Op 

study, and then open the image to be added. 
2. Right-Click on the image and select Add Image To UNQ 

Study. 
3. Enter a description for the image in the dialog that 

appears and click the OK button. 
4. Repeat steps 1 and 2 for each image to be added. 
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Presets 
 
The preset provide the user with a quick way to apply pre-
define Window (Width) and Level (Center) to an image. 
These presets allow different types of tissue to be viewed 
depending on the modality.   
 
Before using presets you must first define them through the 
Image Viewer Settings. Please see Chapter 9:  Image 
Viewer Settings for detailed instructions on creating presets. 
 
► To apply a Window/Level preset to your image 
 
1. On the Tools menu, select a preset from the pop-out 

Presets menu. 
 
-or- 
 

2. Right-Click on the image and select a preset from the 
pop-out Presets menu. 
 
-or- 
 

3. Press the number (1-9), which corresponds to the preset 
you wish to apply. Alternately, you can hold the CTRL 
key while pressing the number. 

 
 
☼ In order for your presets to work as designed they must 
first be defined in your Image Viewers Settings. 
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Print to Paper 
 
Printing to paper prints to any local printer. 
 
► To print images to paper 
 
1. Open an image in the Image Viewer. 
2. Right click on the image and then Left-Click on Add 

Image to Print Queue.   
3. Repeat steps 1 and 2 for all images to be printed. 
4. Left-Click the Print Queue button in the bottom left 

corner of the screen to open the Print Queue window. 
5. Select a layout and adjust any other options and then 

Left-Click on the Print button. 
 
 

 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 181 

The Print Queue window offers many options for defining the 
layout of the printed page. There is also a preview of what 
the printout will look like. 
 
Print to Paper Options: 
 

• Set Layout:  You can choose a layout for the printed 
images by adjusting the column and row values with 
the text boxes. After configuring your values, click the 
Set Layout button. The supported layouts include 
common configurations such as “2 X 4”, indicating 2 
columns by 4 rows. 

• Landscape: Select this checkbox to change the view 
from Portrait (default) to Landscape. 

• Header:  Prints Institution name at top of each page. 
• Footer:  Prints patient data at bottom of each page. 
• Annotations:  Prints any annotations that have been 

place on the image. 
• Image Spacing:  Adjusts the spacing between 

images when printing multiple images per/page. 
• Actual Image:  Increase image to actual size. If the 

viewing area is too small the image will be cropped. 
Use the dropdown list to position cropped image in 
frame. 

• #:  This is the number of pages to display in the 
preview window. 

• Clear:  Clears all images out of the print queue. 
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Saving Images to a File 
 
The Opal-RAD Image Viewer has the ability to save any 
image in your study to an external file. This save feature 
supports the following file formats:  Bitmap, JPEG, GIF, and 
PNG.  
 
► To save an image to a file 

 
1. Right-Click on the image and select either With 

Annotations or Without Annotations from the pop-out 
Save Image As… menu (See below). 

2. The Save As dialog box will appear. Select the location 
where you wish to place your saved image.  

3. Enter a file name in the File Name textbox. 
4. Select file type from the Save as Type dropdown list. 
5. Left-Click on the Save button. 
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Sending an Image to an External 
Application 
 
The Opal-RAD Image Viewer contains a feature, which 
allows the end-user to pass a DICOM image to an external 
3rd party application.  
 
Before using this feature your external applications must be 
configured through the Opal-RAD Image Viewer settings 
control panel (see Image Viewer Settings for more 
information). 
 
► To send your image to an external application 
 
1. Right-Click on the image to be sent. 
2. Select an application from the External Tools pop-out 

menu. 
3. Your 3rd party application should launch automatically 

and the DICOM data will be sent. 
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Chapter Eleven 

Image Viewer Settings 
 
This chapter will explore in detail the options available 
through the setting window of the Opal-RAD Image Viewer. 
 
 

Settings Overview .................................................. 
Chapter Contents 
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Settings Overview 
 
The Opal-RAD Image Viewer (OpalViewer) contains a 
special section for the configuring your image viewer’s 
settings. Through the Image Viewer’s Settings window the 
end-user can: 
 

• Add and edit presets. 
• Modify the default screen layout. 
• Configure the workstations display settings. 
• Adjust the magnification window’s size and zoom 

factor. 
• Change your auto-save options 
• Configure any external tools for integration with 

OpalViewer 
 
► To access the Image Viewer Settings window 
 
1. On the Settings menu, select Edit.  
 
 

 
 
 
Once you have finished making your changes to the viewer’s 
settings, Left-Click on the OK button to close the window. If 
you press the Cancel button, without first pressing Apply, 
then all your changes will be lost.  
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Local Tab 
 
On the Locals Tab you will find the fields for adjusting your 
Display, Auto-Save, Interface, and External Tools Integration 
options. 
 
 
 
 
 
 

 
 
 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 188 

User Options Tab 
 
On the Modality Option Tab you will find the fields for 
adjusting you Modality Presets, Screen Layout, and Series 
Layout defaults. Both the presets and layout options are 
modality dependent, which means that you can configure 
different settings for each modality in your Modality list.  
 
 
 
 

 
 
 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 189 

Modality Options Tab 
 
On the Modality Option Tab you will find the fields for 
adjusting you Modality Presets, Screen Layout, and Series 
Layout defaults. Both the presets and layout options are 
modality dependent, which means that you can configure 
different settings for each modality in your Modality list.  
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Annotations Options Tab 
 
On the Annotations Option Tab you will the settings 
necessary to adjust the behavior of the annotation tools and 
toolbar.  
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Chiropractic Options Tab 
 
On the Modality Option Tab you will find the fields for 
adjusting you Modality Presets, Screen Layout, and Series 
Layout defaults. Both the presets and layout options are 
modality dependent, which means that you can configure 
different settings for each modality in your Modality list.  
 
 
 
 

 
 
 
 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 192 

Overlay Config Tab 
 
The Overlay Config Tab contains an interface, which is used 
to adjust the appearance and content of the Image Viewer’s 
overlay text.  
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Toolbox Options Tab 
 
The Toolbox Options contain controls which allow the 
enduser to build a customized set of Image Viewer tool and 
annotations.  
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Local Options:  Display Settings 
 
The Opal-RAD Image Viewer includes support for multiple 
displays. In most cases the pre-configured display settings 
should be sufficient for most hardware configurations. 
However, If you would like to reconfigure these settings you 
can do so through the Display Settings section of the 
Settings control panel. 
 

 
 
 
► To modify your display settings 
 
1. On the Settings menu, select Edit. 
2. Left-Click on the Locals tab. 
3. Left-Click on the Display Settings dropdown list box and 

select your display. 
4. Select one of the 4 display types (i.e. Color, Gray). 
5. Optionally, you can “disable” your selected display, or 

promote it as your Main Monitor. 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 195 

Local Options:  Interface Options 
 
Use these options if you wish to modify the behavior of the 
Image Viewer’s Magnifying Glass tool or Windows and Level 
acceleration. Please see the Chapter 5:  Image Viewing 
Tools for more details on the use of these tools. 
 

 
 
 
The Interface Options include the following settings: 
 

• Magnifying Glass:  This allows you to control the 
size of the magnifying glass window that appears, as 
well as the magnification factor. You can adjust the 
size by entering a new value (in pixels) in the textbox 
labeled “Magnify Glass Size.” You can adjust the 
magnification factor by clicking the up or down arrows 
on list box labeled “px, Factor.” The magnification 
factor ranges from 1 to 5. 

• Windows/Level Acceleration:  This represents the 
speed with which an image’s Window and Level are 
adjusted when using the Window/Level tool. The 



Opal – RAD User Manual 

Opal-RAD is a registered trademark of Viztek, Inc.  2009 196 

higher the number, the faster your image’s Window 
and/or Level will change when using the W/L tool. The 
lower the number, the slower the changes. 

• Ignore Windows Bar:  When active, this feature 
forces the Image Viewer to load in the entire viewable 
screen area. If the Windows Taskbar is visible it will 
likely obscure the very bottom of the viewer. 

• One Click Annotations:  Annotations, such as the 
Line or Angle tool, will normally only work once before 
having to be reactivated. If you would like to disable 
this default behavior, simply remove the checkbox for 
this item. After disabling this feature you will then 
have to manually deactivate each annotation tool 
when you have finished using it.  
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Local Options:  External Tools Integration 
 
In order to integrate your image viewer with an external 
application, you must first register the application with the 
Image Viewer. 
 

 
 

 
► To Add/Register your application 
 
1. On the Settings menu, select Edit. 
2. Left-Click on the Locals tab. 
3. Enter a Title and Description. 
4. Enter the path and name of the application’s executable 

in the Command textbox. You can browse to the file by 
clicking the button to the right. 

5. Enter “${DICOM}” in the Arguments textbox. 
6. Optionally, enter the path to the working directory in the 

Initial Dir textbox. 
7. Left-Click on the Add button. 
8. Left-Click the OK button to close settings. 
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► To update your application registration 
 
1. Select the application in the large list box. 
2. Modify the fields as necessary. 
3. Left-Click on the Update button. 
4. Left-Click the OK button to close settings. 
 
► To remove your application registration 
 
1. Select the application in the large list box. 
2. Left-Click the Remove button. 
3. Left-Click the OK button to close settings. 
 
 
☼ Currently the only argument the OpalViewer supports is 
${DICOM}. The ${DICOM} argument is merely a pointer 
back to the originally saved DICOM Image on your server. 
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User Options:  Interface Options 
 
The Auto-Save options control how the Image Viewer 
responds when closing your study. By default, you will be 
prompted to save any changes to your images and setting 
on close. You may, however, disable this prompt; or even 
select which options are saved when the prompt appears. 
 

 
 
 
The Interface Options include the following settings: 
 

• Auto Display on Stream:  By default, streamed 
studies will not auto-display in the viewer. This feature 
disables that behavior. 

• 2 Column Thumbnails:  Displays 2, rather than 1 
column of thumbnails in the Series Stack window. 

• Show W/L On Toolbar:  This will create a Window 
and Level tool button on the Image View toolbar.  

• Hold For Record:  This option will reconfigure the 
Philips Speechmike recorder to only record dictation if 
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the Record button is depressed. By default, the 
Record button operates as a toggle. 

• Open Key Images as Single Image:  This will stack 
key images in the Series Stack window, rather than 
separating them into individual thumbnails. 

• Show Red/Blue Swap Button For Color Images:  
This will create a Red/Blue Swap tool button on the 
Image Viewer toolbar. Note – the red and blue areas 
of color Ultrasounds indicate the flow of blood toward 
or away from the Transducer. 

• Caliper Zoom:  When active, this feature will allow 
the user to Left-Click and drag on the measurement 
overlay to zoom into an image. 

• Focus-In On Zoom Point: As images are magnified 
using the Zoom tool, the image will reposition itself to 
center on the cursor position. 

• Fill Empty Cells:  If there exists any remaining 
available Image viewer panes after a pre-saved 
display setting has been applied, they will be filled 
with additional series. 
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User Options:  Auto-Save Options 
 
The Auto-Save options control how the Image Viewer 
responds when closing your study. By default, you will be 
prompted to save any changes to your images and setting 
on close. You may, however, disable this prompt; or even 
select which options are saved when the prompt appears. 
 

 
 
 
The Auto-Save Options include the following setting: 
 

• Ask on Close:  This will provide you with a dialog box 
each time you close the viewer. 

• AutoSave Image Properties on Close:  This will 
save any changes to your images window, level, 
rotation, or orientation to the database. 

• AutoSave Image Annotations on Close:  This will 
save any added, removed, or modified annotations to 
the database.  
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• Auto Mark Read Study on Close:  This will 
automatically change the study’s status to “Read” 
upon close. 

• Auto Upload Dictation on Close:  This will save any 
dictations to the Study upon close. 

• AutoSave Viewer Settings on Close:  This will 
automatically save any changes to your Image Viewer 
Setting upon close. 

• Auto Open Next Study:  The next study on the Study 
List, regardless on the status, will be opened in the 
viewer. When the current study is closed. 

• Auto Save Study DM:  The layout of the current 
study will be automatically saved as the “Default” 
display setting for the study. 

• Overwrite Current Study DM on Auto Save Study 
DM:  If Auto Save Study DM is active, and there 
already exists a “Default” display setting, the setting 
will be overwritten when the current study is closed.  

 
 
 
 
 
 
 
 
 
 
 
 

Modality Options:  Creating Presets 
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A preset is a pre-defined Window and Level setting which 
can be applied to an image by way of a Hot-Key or through 
the Image Viewer’s context menu. The Window and Level 
presets settings can be found on the “Modality Options” tab. 
 
► To define a preset 
 
1. On the Settings menu, select Edit. 
2. Select a “Modality” (i.e. CT, MR), and then a “Key” (i.e. 1, 

2, ctrl+1)  
3. Enter the Description, Window Width (Window), and 

Window Center (Level) in the provided textboxes. 
4. Left-Click on the Set button. 
5. Repeat steps 3 – 5 for each preset you need to define.  
6. Left-Click the OK button to close settings. 
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Changing the Default Layout 
 
The ability to change the viewers default layout is available 
on the “Modality Options” tab. This pre-configure layout is 
modality specific. For example, you could configure all CTs 
to be displayed in a 2x2 format, and all MRs to be displayed 
in a 1x3 format.  
 
► To change your Screen or Series layout 
 
1. On the Settings menu, select Edit. 
2. Left-Click on a Modality (i.e. CT, MR) 
3. From the Screen Layout (or “Series Layout”) dropdown 

list, select an option (i.e. 1x1, 2x2, 3x4). 
4. Left-Click the OK button to close settings. 
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Annotations Options:  Interface Options 
 
In this section of the Annotations Option Tab you will find the 
settings necessary to adjust the behavior of the annotation 
tools and toolbar. 
 

 
 
 
The Interface Options include the following settings: 
 

• One Click Annotations:  When active, annotations 
will automatically turn themselves off after they have 
been drawn. If this is disabled, annotations will remain 
active until they are manually disabled. 

• Show One Click Annotations Button:  This will 
place the One Click Annotation toggle button on the 
toolbar. 

• Annotation Edit Mode:  This option sets the default 
state (on or off)of the Annotation Edit Mode button 
when the Image Viewer is launched. 
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• Use Dot Cursor:  Activating this will change your 
Annotation Edit Mode cursor into a dot, rather than a 
crosshair. 

• Show Annotation On Thumbnails:  When this is on, 
all annotation drawn on an image will also appear on 
the images thumbnail in the Series Stack window. 

• Allow Drag Create:  Normally annotations are drawn 
by using a series of Left-Click operations. With this 
on, you will be able to Left-Click and Drag to draw 
many of your annotations. 

• ROI Show Size:  When this is on, the Length and 
Area values of a Region Of Interest (ROI) annotation 
will display along with the Min, Max, Mean, and STD 
Deviation values. 
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Annotations Options:  Color Settings 
 
In this section of the Annotations Option Tab you will find the 
settings necessary to adjust the colors of your annotations 
fro both color and grayscale monitors.  
 
Using the dropdown color palettes, you may adjust the 
default color of all saved annotations that have been drawn 
on your images. You may also adjust the color of the 
annotation when the user either hovers the mouse cursor 
over it, or Left-Clicks on it.  
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Overlay Configuration 
 
The Overlay Config Tab is use to customize the list of 
displayed DICOM element that appear when overlays are 
enabled in the Image Viewer.  
 

 
 
 
► To add a DICOM tag to your image overlays 
 
1. On the Settings menu, select Edit. 
2. Left-Click on the Overlay Config tab.   
3. Left-Click on the DICOM tag you wish to display from the 

Available Tags list. 
4. Left-Click the Add button to in either the Left Overlay or 

Right Overlay panels to add the element to the list. 
5. Left-Click the OK button to close the settings window.  
 
► To remove a DICOM tag from your image overlays 
 
1. On the Settings menu, select Edit. 
2. Left-Click on the Overlay Config tab.   
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3. Left-Click on the DICOM tag you wish to remove from the 
overlay panel (Left or Right). 

4. Left-Click the Remove button from the overlay panel 
which contains the highlighted tag to remove the element 
from the list. 

 
► To update a DICOM tag on your image overlays 
 
1. On the Settings menu, select Edit. 
2. Left-Click on the Overlay Config tab.   
3. Left-Click on the DICOM tag you wish to modify from the 

overlay panel (Left or Right). 
4. Modify the value in the textbox directly below the overlay 

panel to adjust the display text, being careful not to erase 
the “%S” text string. 

5. Left-Click the Update button from the overlay panel 
which contains the highlighted tag to save your changes. 

 
 
You may optionally move your tags up or down the list of 
displayed tags, by Left-Clicking on the tag to be moved and 
then Left-Clicking on the “+” or “-“ buttons. 
 
 
☼ It is critically important that you do not modify or remove 
the %S text when adding or updating your overlay tags. If 
this text is removed, then no value will appear in the 
designated spot on the overlay text regions. 
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Toolbox Options 
 
The Toolbox Options Tab is use to build a customized list of 
image tools and annotations This benefits the user by giving 
him/her the ability to quickly locate and use tools that they 
frequently use.  
 

 
 
 
► To create a custom toolbox 
 
1. On the Settings menu, select Edit. 
2. Left-Click on the Toolbox Options tab.   
3. Left-Click on the tool or annotation in the list on the left. 

Expand the list of tools, by Left-Clicking on the “+” icon. 
4. Left-Click the ”→” button to add the tool to your toolbox. 
5. Repeat Steps 3 and 4 for each tool you wish to add. 
6. Adjust your other options as needed, and then Left-Click 

the OK button to close the settings window. 
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The Toolbox Options include the following settings: 
 

• Number Of Visible Rows:  This sets the number of 
rows displayed when the toolbox is created.  

• Button Size:  This value represents the size of the 
toolbox buttons (in pixels). 

• Button Separation:  This value represents the 
amount of space (in pixels) that is placed between the 
buttons in the toolbox. 

• Orientation:  Set the position of the toolbox to either 
above or below the Series Stack window. 

 
 
 

 
Custom Toolbox with 5 tools 

 
 
You may optionally move your tools up or down the list to 
changed their position (left to right) within the toolbox control. 
This can be done by Left-Clicking on the tool to be moved 
and then Left-Clicking on the “+” or “-“ buttons. 
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Saving Your Settings 
 
Unless they are saved, any changes you make to your 
Image Viewer’s settings will only be temporary. In other 
words, they will only apply to the current study that you are 
viewing, and once you close the study, those changes will be 
lost. But there is a way to ensure your viewer’s settings are 
saved permanently. 
 
► To save your Image Viewer settings 
 
1. On the Settings menu, select Save. 
 
 
If you would prefer to have your viewer’s settings saved 
automatically you can do so through the Auto-Save feature 
of the settings window. When using this feature it is not 
necessary to manually save your settings before closing the 
image viewer. 
 
► To enable the Auto-Save Settings feature 
 
1. On the Settings menu, select Edit. 
2. Left-Click on the Locals tab.   
3. Place a check in the box marked Auto-Save Settings on 

Close. 
4. Left-Click the OK button to close settings. 
 
☼ Please see “Auto-Save Options” in this chapter for more 
information on all your auto-save features. 
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Chapter Tweleve 

Windows Primer 
 
Opal-RAD software is designed to run like many other 
Microsoft Windows programs, in order to facilitate its use.  If 
you are unfamiliar with Windows in general, please use this 
chapter to get an understanding of basic concepts in 
Windows. 
 
 

Using the Mouse .................................................... 
Chapter Contents 

215 
Using the Keyboard ............................................... 217 
Menu bars (“Menus”) ............................................. 218 
Context Menus ....................................................... 219 
Toolbars ................................................................. 220 
Scrollbars ............................................................... 221 
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Using the Mouse 
 
The mouse is your basic interface with the computer.  It has 
two large buttons on top (sometimes three, sometimes a 
mouse wheel in the center) and a ball on the bottom that 
detects movement.  (Go ahead, pick the mouse up and look 
at the bottom side to see the ball!)  The two large buttons are 
called the “left mouse button” and the “right mouse button,” 
respective of their placement on the mouse. 
 
The intended method of using the mouse is to rest your right 
hand on the top of the mouse, with your index finger 
positioned over the left mouse button, and your middle finger 
positioned over the right mouse button. 
 
If you look at the computer screen you should notice a small 
white arrow.  This is called the “mouse pointer.”  With your 
hand resting on the mouse as described above, move the 
mouse over the desk (or mouse pad) and observe that the 
mouse pointer will mimic your movements.   
 
Move the mouse up, down, left, and right, in a circle, etc. and 
observe the mouse pointer.  Practice trying to place the 
mouse pointer on a certain area of the screen, perhaps one 
of the icons you see on the screen. 
 
The buttons are operated but simply pushing down and 
releasing the button. For example, to operate the left mouse 
button (with your hand resting on the mouse as described 
earlier) you simply push the button down with your index 
finger, then release.  This is called “clicking” the mouse, 
named for the little click noise this action produces. 
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Thus, to “click” the mouse means to push one of the buttons. 
The vast majority of mouse click operations in any Windows 
program are performed with the left mouse button. Thus, 
whenever you are directed to “click” or “select” something, it 
is implied that you click with the left mouse button. 
 
If the right mouse button is required to perform a function, 
the instructions will explicitly direct you to “Right-Click” or 
“click the right mouse button.” The right mouse button is 
generally not used as frequently as the left, and is generally 
used to call up “context menus” (pop-up menus that appear 
when right-clicking in certain areas or contexts.) 
 
The other “clicking” term you hear about is to “double-click.”  
This means to click the left mouse button twice in quick 
succession. This is often a difficult technique to master for a 
beginning computer user, so practice makes perfect. 
Thankfully, Opal-RAD Client and Web Worklist only makes 
use of the Double-Click in one place (selecting a study to 
view from the Study List). 
 
 
This manual uses the common notation: 
 

• Left-Click or Click: This refers to clicking the left 
mouse button once. 

• Right-Click: This refers to clicking the right mouse 
button once. 

• Double-Click: This refers to rapidly clicking the left 
mouse button twice. 
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Using the Keyboard 
 
While most tasks utilize the mouse, there are operations 
requiring the keyboard, such as typing in search terms or 
annotation text. 
 
The keyboard is laid out much like a typewriter.  If you are 
familiar with a typewriter you will feel right at home on the 
keyboard in a short time. 
 
A notable addition on a computer’s keyboard is the set of 
arrow keys.  These are four keys, grouped together on the 
right side of the keyboard (between the main letter keys and 
the numerical keypad), which are labeled with arrows 
pointing up, down, left, and right. 
 
The arrow keys can be used to move the cursor around 
while typing in text.  Opal-RAD Client Worklist makes use of 
these keys as shortcut keys to scroll through series of 
images.  Pecking the right-arrow key will take you to the next 
image; the left-arrow key will take you to the previous image. 
 
Immediately above the arrow keys is a group of six keys also 
used as shortcut keys. The DELETE key (sometimes labeled 
“DEL” for short) can be used to delete annotations.  The 
HOME and END keys are used in navigating a series of 
images; HOME will take you to first image, END to the final 
image.  The PAGE UP and PAGE DOWN (sometimes 
labeled “PgDn and PgUp”) will take you to the previous 
series or next series, respectively. 
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Menu bars (“Menus”) 
 
Menu bars are found along the top of most Windows 
program, and are useful for concealing large menus while 
not in use. 
 
Common menus seen in Windows programs are “File”, 
“Edit”, and “Help.”  To pull down a menu from the menu bar, 
simply click the menu title.  (For example, click “File”.)  A 
menu drops down with entries.  To activate an entry, just 
click it.  To hide/close a menu until you need it again, simply 
click the menu name again (e.g., click “File” again.) 
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Context Menus 
 
Context menus are pop-up menus that appear when you 
right-click in certain areas. For example, if you right-click on 
an image in the Image Viewer, the Image Context Menu 
appears. To cancel a context menu, simply move the mouse 
cursor off of the context menu and single-click the left mouse 
button. 
 
Context menus are designed to provide quick access to 
functions or operations that are relevant to that part of the 
program. For more information on the Study List and Image 
Viewer context menus, please see the appropriate sections 
of this manual. 
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Toolbars 
 
Toolbars are collections of shortcut buttons that generally 
appear near the top of a program window, usually under the 
menu bar. These buttons are designed to give quick one-
click access to functions and operations in the program.  For 
example, many Windows programs have toolbar buttons for 
Cut, Copy, and Paste, operations that people use quite 
frequently. 
 
In Opal-RAD Image Viewer, many toolbar buttons also serve 
as an indicator regarding whether certain tools or options are 
enabled. For example, below are pictures of the “Magnify” 
toolbar button.  
 

    
 
The image on the left shows this button when the “Magnify” 
tool is not selected; the one on the right indicates the 
“Magnify” tool is selected. Notice that the button on the right 
appears “lit up.” On grayscale monitors, and in this manual, 
the button will appear lighter in color than its deselected 
counterpart. 
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Scrollbars 
 

Use of a scrollbar is quite simple, and there are a few 
different methods of using one: 

 
Use the end cap arrow buttons. 

 
To scroll down, click the down arrow button at the very 
bottom of the scrollbar. 

 
To scroll up, click the up arrow button at the very top of 
the scrollbar. 

 
Move the slider up or down by dragging it: 
Position the mouse cursor (arrow) over the smaller gray 
bar contained inside the scrollbar. While holding the left 
mouse button down, move the mouse up or down to 
move the slider accordingly.   

 
 
Click in the empty area of the scrollbar (in an area where the 
inner gray slider is not located) above or below the inner 
gray slider to move the bar up or down accordingly.  This is 
similar to the operation of the “PAGE UP” and “PAGE 
DOWN” keys on the keyboard. 
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